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LAST MONTH WE launched a brand–new 
app for Mac|Life readers, which 
coincides rather neatly with the switch 
to a digital–only format. The new app 
looks really great, and it makes it easier 
to navigate and read your issues. 
There’s also an RSS feed that means you 
can check out the latest news from one 
of our sister Apple brands, iMore. Not 
only that, but the iOS/iPadOS app also 
works natively in macOS, but only on 
Apple silicon Macs. In the newsletter 
that I sent out at the end of last month, 
I explained in detail how the app works 
on a Mac, and that there are some 
quirks to the user experience, mainly 

down to it being an app designed to work with a touch screen. 
I also realized in that same newsletter there were a few things I 

neglected to clarify. First of these is exactly which app to 
download from the Mac App Store. Unfortunately, it’s come to 
my attention that some readers have been unwittingly 
downloading a German version of the magazine (Mac Life | 
Magazine, as it’s listed on the Mac App Store), which isn’t made 
by us. Unless you Deutsche sprechen, the one you want is actually 
listed as Mac|Life Magazine. I appreciate this is all terribly 
confusing, and I’m sorry for not making it clear in the first place. 
To avoid any further confusion, I’ve done what I should have 
initially, and provided a link to the app you need, so here it is in 
shortened bit.ly format: https://bit.ly/maclife_mag. Fingers 
crossed this enables everyone to download the right app to read 
the magazine on their Mac.

On that note, I’ve had a few people ask me what they can do if 
they don’t have an Apple silicon Mac. The answer is: PocketMags. 
This will work on any Mac (or indeed, any device), and will allow 
you to access and read your Mac|Life subscription here, rather 
than through the official Mac|Life app.

Have you downloaded the new app yet? What do you think? 
And have you tried using it on an Apple silicon Mac? I’m very 
interested to know your findings, so feel free to feed back to the 
usual address: letters@maclife.com. 

A NEW MAC|LIFE APP!      THE TEAM
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Final Cut 
Pro and 
Logic Pro 
for iPad
 
Pro video and music  
apps come to iPad

BY ALEX SUMMERSBY

and write directly on top of video 
content using Apple Pencil. On iPad 
Pro models with M2 chips, Apple 
Pencil hover enables you to quickly 
skim and preview footage without 
ever touching the screen. Add a Magic 
Keyboard or Smart Keyboard Folio to 
utilize key commands. Creators can 
view and edit stunning HDR video — 
taking advantage of the Liquid Retina 
XDR display on the 12.9–inch iPad Pro 
— and apply color grades with 
accuracy using Reference Mode.

LOGIC PRO FOR iPAD
Logic Pro for iPad combines the power 
of Apple’s pro music creation suite 
with the portability of iPad, with a 
complete collection of advanced tools 
for songwriting, beat making, 
recording, editing, and mixing.

With Multi–Touch gestures, music 
creators can play software 
instruments and interact naturally 
with controls, as well as navigate 
complex projects with pinch–to–zoom 

APPLE HAS UNEXPECTEDLY 
introduced iPad versions of 
Final Cut Pro and Logic Pro. 
Both apps will each be available 
on a subscription basis through 
the App Store for $4.99 per 
month or $49 per year, with a  
one–month free trial. Final Cut Pro 
will run on iPads with M1 chip or 
newer, and Logic Pro on iPads with 
A12 Bionic chip or newer. Both require 
iPadOS 16.4.

Final Cut Pro for iPad introduces a 
powerful set of tools for video creators 

from one portable device. A new jog 
wheel makes the editing process 
easier than ever and enables users to 
navigate the Magnetic Timeline, move 
clips, and make fast frame–accurate 

With Live Drawing, users can draw 

and swipe–to–scroll. Plug–in Tiles put 
the most useful controls at the 

quickly shape sounds.
There’s an all–new sound  

 
and with Multi–Touch, creators  
can play instruments using a variety 
of play surfaces. Logic Pro on iPad 
comes with a massive collection of 
realistic–sounding instruments and 
powerful synths including Sample 
Alchemy — a new sample 
manipulation instrument that can 
transform any audio sample with the 

A full–featured mixer — complete 
with channel strips, volume faders, 
pan controls, plug-ins, sends, and 
precise automation — gives users 
everything they need to create a 
professional mix entirely on iPad. The 
app supports roundtrip capabilities, 
making it easy to move projects 
between iPad and Logic Pro for Mac 
(10.7.8 and macOS 12.3 or newer). Work with over 100 instruments and effects plugins.

Capture, edit, and 
publish from a single 
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> Messaging changes
From your Apple Watch, no. On Windows, yes

FACEBOOK’S PARENT 
COMPANY, Meta, has 
announced that 
Facebook 
Messenger will no 
longer be available 
as an app for 
Apple Watch. 
However, you’ll 
still be able to get 
Facebook 
Messenger 

Watch when it’s paired 
— you just won’t be able 
to reply from your wrist. 

Other Watch apps that 
have been discontinued include Twitter, 
Instagram, and Slack. Apple has been 

features of Apple Watch rather than 
standalone apps, but it is not clear 

messaging and other apps being 
discontinued. Commentator Mark 
Gurman says an iPhone–like app–
centric experience “doesn’t always 
make sense on a watch.”

Separately, 
Microsoft has 
released software 
that enables 

Windows 11 users to 
send and receive 
messages and calls 
via an iPhone. “Phone 

basic iOS support for 
calls, messages, and 
access to contacts,” 
Microsoft said. 
Your Windows device 

won’t directly connect to 
any Apple online services, 

just connect to your iPhone 
over Bluetooth. This is in contrast to the 
Apple Music and Apple TV software for 
Windows. Also, Windows 11 Photos has 
support for iCloud Photos built–in.

Phone Link for iOS has been described 
as the latest software release from 
Microsoft to make it easier for Windows 
users to own an iPhone — or possibly, to 
put it the other way around, to persuade 
iPhone fans that they don’t need to 
abandon Windows.

> New security updates
DID YOU RECEIVE an unfamiliar 
security alert urging you to update your 
iPhone, iPad, or Mac immediately? Not 
everyone did, but this wasn’t a fake. It 

update designed to deliver important 
security improvements between the 
usual software updates — for example, 
improvements to Safari, the WebKit 
framework stack, or other critical 

some security issues more quickly, such 
as issues that may have been exploited 
or reported to exist in the wild.

delivered only for the latest version of 
iOS, iPadOS, and macOS — beginning 
with iOS 16.4.1, iPadOS 16.4.1, and 
macOS 13.3.1. By default, devices will 

applied automatically and, if necessary, 
will prompt you to restart the device. 
Find out more at https://support.apple.
com/en-us/HT201224.

News in 
brief
A bite of the Apple

> STEVE JOBS IN HIS OWN WORDS
The online Steve Jobs Archive has 
released a curated collection of the late 
Apple CEO’s speeches, interviews and 
correspondence, available for free at 
https://stevejobsarchive.com/book to 
read online or download for your  

Featuring an introduction by Laurene 
Powell Jobs, Make Something 
Wonderful
window into how one of the world’s 
most creative entrepreneurs 
approached his life and work. In these 
pages, Steve shares his perspective on 
his childhood, on launching and being 
pushed out of Apple, on his time with 
Pixar and NeXT, and on his ultimate 
return to the company that started it all.

The latest news from the world of Apple
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you with a comprehensive overview  
of AI and its potential to transform 
our lives.

THE POWER OF CHATGPT
Confession: your author did not write 
the previous paragraph. Instead, it 
was generated, in mere seconds, by 
text–based AI tool ChatGPT. It 

months AI has taken a giant leap 
forward as multiple major tech 
companies have accelerated their 

public. ChatGPT comes from research 

(https://openai.com), whose next–
gen AI tool, GPT–4, promises to be 

recently partnered with Microsoft to 
provide the AI behind its search 
engine Bing. Not wanting to be 
left out, Google is also jumping on the 
AI bandwagon with Google Bard. Plus, 
there are image–generating services 

and the independent Midjourney, 
which are also growing in popularity. 

are “generative” as well as responsive 
i.e. their algorithms can be used to 
make something new, raising 
questions about the power of  
human creativity.

Robert Scoble is a tech blogger and 
futurist who is deeply involved in the 

(AI) has become an 
increasingly prominent 

landscape. With its ability to learn, 
adapt, and make decisions 
autonomously, AI has the potential 
to revolutionize various aspects of our 
lives. From business and healthcare 
to education and entertainment, AI is 

shaping the future. In this article, 

applications, and its potential impact 
on the world we live in. Whether 

curious about the latest advancements 

 INVESTIGATES

A

The pros  
& cons
AI gadgets are here and they’re  
only going to get more powerful.  
The question is: are Apple and the public 
ready for them? CHARLOTTE HENRY
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a period of massive change for human 
beings. This is a tool that most people 

This is a very deep tool that answers 
any questions human beings have.”

Thanks to the image–creating tools, 

a holodeck, right? Five years from now 

environment do anything.”

APPLE AND AI
We know Apple is interested in AR/VR 

else is the company doing in this 
rapidly developing space? ChatGPT 
informs us: “Apple has been actively 
involved in the development of AI 
technologies for many years. The 
company has a dedicated AI research 
team, and its products, including Siri, 
use AI to provide intelligent, 
personalized experiences for users. In 
recent years, Apple has also made 

learning and computer vision, which 

as facial recognition and augmented 
reality experiences in its devices. 
Additionally, Apple has made several 

startups to bolster its capabilities in 

areas such as natural language 
processing and computer vision. 

continues to explore new applications 
and advancements in this rapidly 

All information generated via AI 
needs to be checked, of course, but it 
is hard to disagree with much of the 
above. Apple is interested in the AI 

aforementioned services. 

building AI algorithms that help 
compress video. In typical fashion,  

The latest news from the world of Apple
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Apple’s M chips incorporate the Neural Engine for better voice recognition and image processing.

piece for 9to5Mac: 

were quite impressive, although 
limited. Siri could show you the 
weather, set a timer, search the web, 
call someone, play a song, or create a 
reminder. All based on voice 
commands. Apple always said that 
this was just the beginning. But it 
turns out that Siri never reached its 
full potential.” 

Scoble agrees. “I think Apple, on 

way in at any point… If you look at it 
today, Siri sucks.” He explains that 
there could be more from Apple in the 
future. “They built a lot of AI in their 
chips that has not yet been turned on. 
They built a new kind of mesh 

house that is not yet turned on.”
Scoble feels that Apple “are behind 

right now”. He adds that while Google 

it “should win all contests in AI 
because they have the most data and 
because it has the biggest AI team.” 

LEGALITY FEARS
While the rapid development of 
evermore powerful AI models is 
exciting, there are some who have 
concerns over problems ranging from 
potential job losses to privacy issues. 

authority banned ChatGPT and opened 

there was little fanfare, and no 

Apple. We started our journey at 

learning/deep learning video 
technology could potentially change 
the world. Apple saw this potential 
and took the opportunity to add it to 

like TechCrunch also noticed that 

relevant divisions at Apple.

LAGGING BEHIND?

intervention into this space. For years 

it had been acquiring AI companies 
and the shopping spree is unlikely to 

back to the start. Siri is something we 
take for granted now, but it was one of 

not had a major overhaul since its 

far behind the capabilities of other 
tools that have emerged since. As 

Siri falls into the “could do 
better” category in modern 

AI comparisons.

MACHINES FLOOD 

UNTRUTH? 
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happening rapidly, things are moving on fast from 
apps using machine learning.

Almond, executive director, 
Regulatory Risk at the Information 

or using generative AI should be 
considering their data protection 
obligations from the outset, taking a 
data protection by design and by 
default approach.” He added, “this 

These are not the only regulatory 
bodies that have raised concerns. 

our society, we are currently not 
protected enough from the harm it 
can cause people. In only a few 
months, we have seen a massive  
take–up of ChatGPT and this is only 
the beginning.”

MISINFORMATION CONCERN
Another major issue is 
misinformation. Scoble gives the 
example that he asked ChatGPT for 
food recommendations at a restaurant 
during a trip to Texas. Two items 
it suggested did not feature on the 
menu. Now, this might seem a 
harmless example, but that is not 
always the case. For example, AI tools 

appearance in a New York City 
courtroom. Very dangerous in 
a volatile political environment.

Andreas Rindler, managing  
director at BCG Platinion, part  
of the giant Boston Consulting Group, 
commented: “As generative AI tools 
such as ChatGPT and Bard continue to 

misinformation and bias can wreak in 

these tools are inherently ethical and 
safe. But it would be hasty to call for a 

needed is a responsible and ethical 
approach that permeates every aspect 
of our society.”

 That, though, is exactly what Apple 
co–founder Steve Wozniak and others 
have done. Along with tech leaders 
and academics, he signed a letter 
calling for a six–month pause on AI 
development. The document said that 
“AI systems with human–competitive 
intelligence can pose profound risks to 
society and humanity… we must 
ask ourselves: should we let machines 

propaganda and untruth?”

EMBRACE CHANGE?
Scoble acknowledges the risk, but is 
also more stoic. He urges people to 
verify anything their digital devices 
tell or show them, but believes many 
of the objections stem from the fact 

foresees that major disruption will 

“This is the human imperative now. 

anymore… you cannot stay in your 

going to get more powerful. We had 
better get used to it. 

>>> Key AI tools

ChatGPT
From OpenAI, this is the 
current leader in text–based 
AI. Enter written prompts, 

respond to refine the replies.

Google Bard
Another text–based tool, 
Google Bard currently lags 
behind ChatGPT but is set 

powerful as time goes on.

Dall·E
Input text prompts and 

extremely easy to use.

Midjourney
An image–generating tool 
that is similar in principle to 
Dall·E, although you’ll need 
to be a member of the 
Discord community to use it.

The latest news from the world of Apple
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SINCE APPLE ANNOUNCED A 
CHANGE THAT GOT ME EXCITED

But again, I’m not sure I really 
blame Apple. At this point, we’re 
all so set in our ways on how we 
want computers to work. I can tell 
you that fans of Windows are up 
in arms every time Microsoft tries 
to make changes to the OS for the 
better, and it’s not like users of 
Windows are famed for loving it as 
is. We’ve just reached a point 
where there are fewer and fewer 

attempt to add more runs the risk 
of breaking old ones.

Once we reached a certain 
amount of computing power and 
memory, we started hitting 
diminishing returns — the 
machine wasn’t the bottleneck 
anymore. This happens in other 
areas too. Attempts to change the 
fundamental designs of cars are 
met with disdain; there are people 
who will never read an ebook 
because it isn’t made of paper. 
Maybe Apple is working on 
amazing ideas that will push Macs 
forward, or maybe future macOS 
updates will be boring because, 
over time, people become boring.

PERHAPS I AM in the minority, 
but it’s been a long time since 
I was excited about anything 
happening with Apple’s 

software on the Mac. Hardware, 
sure: the M–series chips have 
obviously been a seismic event, 
and the miniLED screens on the 
new MacBook Pros are gorgeous. 
But even the M–series chips didn’t 
enable new software that thrills 
me. The biggest change made 
possible there was having iOS apps 
on the Mac, and this didn’t exactly 
get me jumping on the couch, Tom 
Cruise–style.

I’ve written in these pages in the 
past that I think Apple has failed to 
build on what it could be doing 
with a modern–day iLife suite — a 
dedicated podcasting app, a 

MATT BOLTON thinks the Mac has become 
boring when it comes to software, but 
maybe that’s just the arc of the universe

> THE SHIFT

creation tool, a version of iMovie 

people get more creatively savvy 
— but I can understand why that 
wouldn’t be a priority. The point of 
iLife was to make the new era of 
digital media look easy on a Mac, 
but now there are web–based tools 
that can do so much of what I’m 
talking about. Apple could do it 
better in a lot of ways, but whereas 
once iLife was like Prometheus 
handing the power of the pro 
digital media gods to humanity, 
now we’d probably just shrug and 
point out that we’ve been using 

for years, and we’re kind of settled 
into all the weird quirks of how it 
works now, thanks. 

It’s not just that Apple isn’t 

It’s been a long 
time since Apple 
announced a 
change that got me 
excited that 
working on my 
Mac was about to 

become faster. Apple has 
introduced a lot of quality–of–life 
changes, no question — mainly 
around security and privacy. But I 
remember the introduction of 

of Stacks in the Dock… all things 
that made me go “Ooooh, that’s 
gonna save me some time,” 
probably while narrowing my eyes 

in satisfaction. While I did narrow 
my eyes when Stage Manager was 

announced, it was only a result 
of my brow furrowing in confusion. 

Remember what it was like before Quick Look? 

10    JUNE 2023



EMAIL: letters@maclife.com
FACEBOOK: facebook.com/maclife TWITTER: twitter.com/maclifeSHARE WITH US!

I believe that a 
significant 
improvement 
for your 
magazine, and 
your readers, 
would be being able to 
translate the text like we 
can do when reading other 
digital titles. Reading an 
article that’s a bit too 
technical? Simply convert 
it to the language you 
would like — French in my 
case — and voilà! Anyone that does 
non speak English can fully read any 
text in the magazine! This would be 
great for us and for you. In addition, 
this allows the reader to copy part of 
the text to insert in a note or email. 

On another equally important 
subject: are you still planning an 
index or search engine for MaclLife? It 
is not available yet. I couldn’t find 
the edition you last promised to your 
readers, but I do remember you 
mentioning it.

I am an avid reader of your 
magazine. I always look forward to 
reading it every month. 
PIERRE DENAULT, MONTRÉAL

Hi (and bonjour!) Pierre — 
thanks for getting  
in contact. 

Unfortunately as  
our magazine is  
a PDF, we  
don’t have the 
ability to  
change the 
language of  

the magazine. The only  
way we would be able to  
do that would be to build  
the magazine from scratch  

in the language of our choosing!  
That being said, there is the option  
of viewing issues with the text  
reader function within the app, so at 
present our development team is 
looking at the idea of being able to 
convert text within the app. It’s not 
possible now, but it might be in a 
future release of the app.

As to the index — yes you can  
already search for things within  
the app. If you go to the “My Library” 
tab, there’s a search function to the 
left. Here you can search through 
issues you’ve already purchased (sadly, 
this doesn’t work for issues you 
haven’t purchased).

Digital memento
I have a big task. I am a 91–
year–old with four kids. They’ve 
asked me to record interesting 
pieces of my life. Can I dictate 
and record on my iMac? If so, 
can I do it with FaceTime? How 
would I transfer files to a CD 
disc or other device to make a 
duplicate for each child?  
JACK ROEHM

What a privilege! In answer 
to your question: yes, you 
can record a FaceTime video, 

and it’s easy. There’s no 
option within FaceTime 
itself, but the Mac has a 
native screen recorder 
which can be quickly 
accessed. When you’re in 
FaceTime get to it by using 
the shortcut Shift + CMD + 5. 
From the Options menu, 
choose the location to 
record to, and the mic to use. 

Then, select Record 
Selected Portion, drag the 
corners of the highlighted 
window to suit the FaceTime 

then when I see an article or 
two I’m interested in. That 
being said, when I read in the 
April issue that you will soon 
stop the printed version, I was 
left with a dilemma. While I 
understand your reasoning, I 
was wondering what would 
happen to non–subscribers 
like me. Will you also allow us 
the option of accessing 
individual digital issues as 
needed/wanted? Or will I have 
to say goodbye? MIKE

There’s good news here Mike 
— yes, you definitely can 
purchase ad hoc. There's an 
option to buy magazines 
individually either within the 
Mac|Life app, or via our own 
magazine site Magazines 
Direct. Depending on how 
many issues a year you read, 
you might find it better value 
for money to purchase a 
year’s digital subscription.

Another way
I had to respond to Brian 
Wallace’s letter in the spring 
issue about having the 24 
most frequently used apps 
show up automatically on the 
first page of his Home Screen.

You were right about just 
biting the bullet and doing it 
manually, but there’s one very 
important thing that I think 
makes a world of difference. I 
take the icons for those apps 
and put them in alphabetical 
order. This way I pretty much 
have a logical idea of where 
they are… or should be.
KEITH E GATLING 

Good to hear from you 
(again!) Keith. This is a great 
idea — it’s not something 
we’ve tried before, but if it 
works for you then it must 
be worth a look.

LETTER OF THE MONTH

app, and then hit the Record 
button. We’d advise copying 
the  file onto a USB thumb 
drive (several times, in this 
instance), or uploading to 
the cloud and giving your 
children access to them.

Occasional reader
I love your magazine but I’m 
not a subscriber, mainly 
because I don’t have time to 
read every issue. However, 
when I’m at a news stand, I do 
purchase an issue now and 

Image rights: Getty.
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MAKE YOUR MAC 

WRITTEN BY IAN OSBORNE

Your Mac is a powerful beast, but there are many ways 
to enhance its performance even further. With our guide, 

you can eke out every ounce of power

MAKE YOUR MAC 
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RE YOU CONFIDENT that your 
Mac is running to its maximum 

powerhouse of modern computing it was 
when you first bought it, or has it 
gradually been cluttered with duplicates, 
space–hogging data, and endless media? 

keep tabs on what you have on your 

machine, and declutter it regularly to 

And are you using its time–saving  
and organization features to the fullest? 
The Mac has all manner of features to help  
you keep on top of your work, with some 
great tools for the Finder and awesome 
ways of keeping control of the Desktop. 
There are some excellent apps available 

organizing files too.

Over the next 12 pages, we show  
you how to cut down on the clutter  
by identifying duplicates and large, 
forgotten files, and moving media such  
as TV shows, movies and music to 
external drives. We also show you how  

 
often overlooked features, such as  
Smart Folders, Mission Control,  
Stage Manager and more, as well as 

 
Mac in shape.  

A
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HOULD YOUR MAC be groaning 

https://daisydiskapp.com

It’s clean–up time

S

Housekeeping apps: 
good or bad? 
Some Mac owners swear by clean–up 
and maintenance apps such as 
CleanMyMac X and MacKeeper, while 
others have their doubts. Those in favor 

of unwanted system junk, freeing 
memory, and more. Others say these 
apps are unnecessary, and perhaps even 
harmful if used incorrectly. And the same 
is true of us here at Mac|Life; while some 
of the team are fans of apps such as 

 
right for you.

THE FOLDER TREE
The folder tree identifies 
which folder or drive you’re 
currently analyzing. You can 

 
to open it.

BREAKDOWN
This list breaks down the 

folder currently being 
analyzed. Click on a category 
to view it.

COLLECTED FILES
Drag files here for deletion, 
then click Delete to erase 
those files. Also, click  
here for a list of files 
currently collected.

THE DISK MAP
This graphic is a visual 
representation of the files 
stored on the drive you’re 
looking at. Hover over one  
to identify it.

INDIVIDUAL FILES
Each segment in the wheel 
represents a different file. 
Its size shows the actual 
file’s size, which is detailed 
on the right.

QUICK LOOK

14    JUNE 2023

Feature

Image rights: Apple Inc, Software Ambience Corp.

https://daisydiskapp.com


HOW TO 

HOW TO 

HOW TO 

1Open a Smart Folder

1Gemini 2 in action

https://macpaw.com/gemini

1 The dupeGuru app

https://dupeguru.voltaicideas.net) is 

Select file type

Scan for duplicates

Search options

 

3 Check duplicates

3 Eliminate them

3 Scan and remove

Make your Mac new again
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HEN YOU’VE FIXED

 

 

A deeper declutter
Take things further when giving your Mac a much–needed tidy

W

Stay up to date
One of the best ways to make sure your 
Mac performs at its best is to keep its 
operating system and apps up to date. 

next to App Store, you have updates. The 

apps bought or downloaded from outside 

(https://corecode.io/macupdater).

MacPaw’s excellent 
CleanMyMac X 

(https://macpaw.
com) can carry 

out, and in some 
cases automate, 

many of the tasks 
suggested in  

this guide.

16    JUNE 2023
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Spotlight searches are great for 
finding things on your Mac, and 
they can be greatly sped up by 
tweaking a few settings. Click the 
Apple icon in the menu bar, then 
select System Settings (Ventura) 
or System Preferences (Monterey 

and scroll the right–hand pane up 
until you reach the section labeled 
“Search results”. Here you will find 
a list of things Spotlight can 

default, but you can uncheck 

the Spotlight Privacy button at 
the bottom. In the pop–up 
window, you can exclude drives 
and folders from Spotlight 
searches. This is very useful if you 
clone your drives as an extra 

Spotlight to search these.

Spotlight preferences

You can speed up your Spotlight searches by tweaking its settings.

https://corecode.io/macupdater
https://macpaw.com
https://macpaw.com


HOW TO 

1Uninstall apps

4Unnecessary language
https://ingmarstein.

github.io/Monolingual

7 Stop spam

Check the list

Remove app code

8GarageBand sounds

 
 

3 Create some space

6Move data to iCloud

Website notifications

Make your Mac new again
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HEN YOUR MAC

Power up the Finder
Mastering the Finder is one of the best ways to improve efficiency on your Mac

Keyboard shortcuts 
There are some great Finder keyboard shortcuts that work 
across the Mac interface, as well as in most apps. Cmd+C 

more comprehensive list of keyboard shortcuts, check  
https://apple.co/3n2Guad.

W

1Open a Smart Folder
 

Search where? 3Add a condition

HOW TO 
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Click the Finder icon in the Dock or anywhere on the 
desktop to bring Finder to the fore. Ctrl–click on the 

Finder icon for a menu full of options.

https://support.apple.com/en-gb/HT201236


ACCESS FINDER
Click anywhere on 

covered by an app or 
 

Finder to the front.

SMART FOLDERS
Open a Smart Folder (see the 
walkthrough below) from 
Finder’s File menu and you 
can set up rules to restrict 
what it shows. 

FORCE RELAUNCH

Apple menu and select Force 
Quit. Click on Finder from the 
options, then choose the 
Relaunch button.

THE SIDEBAR
Each Finder window has its 
own sidebar, from where  
you can easily access 
various folders and drives  
on your Mac. 

FINDER TABS
Finder tabs work similarly to 

 
a new tab.

4Date or file name More conditions 6 Save a Smart Folder

 

Make your Mac new again
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ISSION CONTROL GIVES an 
 

 
 

 
 

 
 

 

  

M

macOS has some great tools for taking control of your desktop spaces

Mission Control 
& Stage Manager

20    JUNE 2023
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1Add desktops Moving apps 3 Full–screen apps

 

HOW TO 

Activate Mission Control and 

window you’re looking for.

Make your Mac new again
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1Open Shortcuts Add your own

 

3Building shortcuts

Mac|Life

OW WE’VE CLEANED out the 

Be a master of organization!
Bringing a little structural discipline to your Mac will boost your productivity

HOW TO 

N

22    JUNE 2023
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Control file 
associations
Do certain files open in the 
wrong app, such as PDFs 
opening in Preview rather than 

master file associations. Ctrl–
click on a file and select Get Info, 
or click on it and press Cmd+I. In 
the info window that appears, 
use the “Open with” menu 

can click on the Change All 
button to make all files of 

4More actions Customize icon

 

6 Shortcuts gallery

HoudahSpot 6
> $34  
> www.houdah.com
Find files fast by building  
a search with added  
conditions. Start with a  
simple search, then refine it  
with further clauses that narrow 
down and improve your results. 
You can exclude folders and set 
up search templates too.

ForkLift 3
> From $19.95  
> https://binarynights.com
This dual–pane file manager  
and file transfer client  
enables you to connect to  
cloud services and remote 
connections, sync folders,  
batch rename files, preview  
files, quick–open favorites  
and more.

Commander One
> From $29.99  
> https://mac.eltima.com
An awesome Finder replacement, 
Commander One offers dual pane 
windows and hotkeys for any 
action. You can show hidden files, 
manage multiple folders at once, 
unlimited tabs, view computers 
on your network and many more 
productivity–boosting features.

There are some great third–party 
apps that can power up the way 
you organize and find files on 
your Mac. Here we take a look at 
some of the best.

Top 5
Organizer 
apps

Path Finder
> $29.95/year  
> www.cocoatech.io
Path Finder integrates with  
a number of cloud services  
such as Dropbox, iCloud,  
Google Drive and more,  
and its Dual Pane View  
makes it easy to copy or  
move files from one place  
to another.

Alfred 5
> Free  
> www.alfredapp.com
Alfred powers up Finder, with 
hotkeys, keywords, text 
expansion and more. The app is 
free, but with the paid–for 
Powerpack, you can build 
workflows that cut down on 
repetitive tasks. It’s a great 
productivity tool.

Make your Mac new again
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Remember 
your Time 
Machine 
backups!
When moving your libraries from your 
hard drive to your external drive, 
make sure you have a Time Machine 
backup before you start. You can then 
fall back on it if something goes 
wrong. A word of warning: never keep 
your media and your Time Machine 
backups on the same drive. If you do 

your files and your backups. Use a 
separate drive for Time Machine, and 
nothing else.

An external drive is a hard drive 
or solid–state drive (SSD) that 

drive requires its own power 
supply; a portable drive is 
powered by the data cable. A 
NAS (Network Attached Storage) 
drive is connected to your 
router, and accessed through 
your network. Make sure your 
external drive is formatted for 

Extended (Journaled) format.

Synology NAS 
Drive DS220J 8TB
> $399.97  
> www.synology.com
This two–bay NAS drive comes 
with two 4TB hard drives pre–
installed. Stream your media 
libraries to any computer or 
mobile device on your network, 
or even over the internet.

ORICO 5 Bay 
External Hard 
Drive Enclosure
> $229.99 > www.orico.cc
For greater flexibility, why not 
buy a multi–drive enclosure and 
add your own hard drives? This 
five–bay device can take drives 

total capacity of 80TB.

WD Elements 
Desktop Hard 
Drive 10TB
> $249.99
> www.westerndigital.com
Desktop hard drives need to be 
plugged in but offer a greater 
capacity. This one holds a huge 
amount of data for your money.

Seagate One 
Touch SSD 2TB
> $149.99  
> www.seagate.com

this is a speedy drive. It can 
store high–def videos and play 
them without lag. It comes with 
USB–C and USB–A cables.

SanDisk Pro 
G–Drive ArmorATD 
5TB
> $179.99 
> www.westerndigital.com
This G–Drive ArmorATD offers 

drive. It has an anodized 
aluminum enclosure, plus an 
easy–to–grip protective bumper.

Get moving
Use external drives for space–hogging files

You can move media libraries such as Music to an external drive.FTER ALL YOUR 

Top 5 
External 
drives

A
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HOW TO 

HOW TO 

HOW TO 

Locate in Finder

1 Consolidate library

1 Transfer libraries

Move your library

Drag across

Choose library

3 iCloud Photos

3 Redirect app

3 Configure the settings

Make your Mac new again
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Ahead of the curve, and endlessly entertaining…
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HOW TO Get started with Apple Music playlists 

Create Apple Music playlists
Enjoy top–quality tunes wherever you go by building your own soundtrack

REQUIRES
macOS 13 or later, Apple 

Music or iTunes Match  
sub (optional) 

YOU WILL LEARN
How to create  

and customize playlists in 
Apple Music for Mac

IT WILL TAKE
20 minutes

say) while excluding others (those you’ve 
“disliked”). Plus you can save playlists and 
sync them across your devices, share them 
as stations on Apple Music and, yes, even in 
2023, burn them to disc so you can share 
them old–school. 

Follow our tutorial’s quick and easy steps 

IF YOU’VE EVER made a mixtape 
or mix CD for a friend or 

know how to create playlists — 
carefully curated compilations of favorite 
tracks that you can’t wait to share.

Playlists on Mac have existed since  

and, although they’ve been 
somewhat eclipsed by streaming 
audio and AI–generated 
“stations” on Apple Music, they 

because playlists are easy to 
create and fun to dream up, and 
with Smart Playlists you can even 
get the Music app for Mac to do 
the heavy lifting for you — by 
applying rules that can 
automatically include some 
tracks (those you’ve “loved”, Learn how to build a Smart Playlist based on a selection of chosen criteria. 

Open the Music app and choose 
File > New > Playlist (Cmd+N) from the 
menu bar. You’ll see a new, empty playlist 
with its name highlighted in pink. Start 
typing to enter your chosen name. Press 
Return to save the name you’ve entered.

now add more. Either use the method 
described in step 2, or simply drag and 
drop the name of the track you want to 
add from the right–hand pane onto the 
playlist name in the Music app sidebar.

Your playlist is still empty, so click 

then scroll to the song in the right–hand 
pane you want to add. Ctrl–click the song 
to see its contextual menu. There, choose 
Add to Playlist then your playlist’s name. 

HOW TO DO ANYTHING ON YOUR MAC, iPHONE & iPAD
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to a playlist, you can change its running 
order. Select your playlist in the sidebar to 
see its tracklisting. Click a track, then drag 

move it to a new playlist position.

If you have “loved” hundreds of 

being rather long. To change that, ensure 
“Limit to” is checked, then choose from the 

and third sections here.

Click the second section 
(“contains”) and again choose from the list 
of options that appears. Choose “is”. The 
third section should now show Music. Click 

Make sure that “Match for the 

sections. Click the left–hand section 
(Artist) to reveal the full list of rules–based 
options. Choose Media Kind here.

If you subscribe to Apple Music 

across your devices. To burn a playlist to 
CD, click the “…” to the right of the playlist, 

your settings in the dialog that appears. 

For the second rule, choose Love 

and Loved from the third. Ensure “Live 
updating” is checked. Now any songs you 
choose to “love” in future will be 
automatically added to the playlist.

Any playlists you create using 
steps 1–4 involve a fair amount of curation. 
So let’s get the Music app to do some of 
the work. Choose File > New Smart Playlist 
(Opt+Cmd+N). A Smart Playlist dialog will 
open, enabling you to add custom rules. 

Once you’re done, click OK to save 
your playlist and give it a name as in step 
1. To change the rules for your playlist click 
Edit Rules at the playlist’s top. To remove a 
playlist, Ctrl–click it in the sidebar and 
choose “Delete from Library”.  

The rule we’ve set ensures our 
playlist only contains media types that 
have been classed as Music. Click the “+” 
button to the right of the rule to add a 
second rule. Repeat steps 6 and 7, only 

How to do anything on your Mac, iPhone & iPad
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HOW TO Make non–destructive Raw edits

Choose File > Open. Browse to a 

Output to Raw Layer (Embedded).

 

REQUIRES
Affinity Photo 2 ($69.99)

YOU WILL LEARN
How to use masks, 

creatively displace text, and 
perform non–destructive 

Raw edits 

IT WILL TAKE
15 minutes

non–destructive Raw editing. This enables 
you to tweak the colors and tones of a Raw 

what’s revealed and what’s hidden on a 

editing abilities. GEORGE CAIRNS

lets you 

around to change reality! If 

PART 
1 of 3

Create

30    JUNE 2023



HOW TO

Make it mono
Open a shot with a colorful 

the entire shot. You can then adjust the 

the rest of the shot. 

 

desaturated by the adjustment layer. 

of the B&W adjustment layer.

HOW TO

creates vector–based text that we can 

You are now free to rotate and 
reposition the text to see how it 
becomes creatively displaced by the 
pixels on the layers below. You can edit 

> 

How to do anything on your Mac, iPhone & iPad
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Get started with Ulysses
This brilliant writing app could be the only word wrangler you’ll ever need

REQUIRES
Ulysses app (from $5.99/
month), macOS 11 or later

YOU WILL LEARN
How to use Ulysses’ simple 

but powerful writing and 
editing tools

IT WILL TAKE
15 minutes

Ulysses uses Markdown, a fast  
 
 

 

 
 

 

 
CARRIE MARSHALL

GENERALLY SPEAKING, THERE are 

HOW TO Utilize Ulysses’ excellent writing tools

A new document

create a new document, so press Cmd+N. 
Now you can type; use Cmd with the “+” or 
“–” keys as you zoom in or out. The panel 
at the right, the Inspector, shows key 
statistics that update as you write.

Input headings
You can use headings and 

subheadings to organize your document. 
Using Opt+3 to put a single hash before 

change those lines accordingly.

Add some style
Ulysses adds links and formatting 

via Markdown markup, and you can see 
the available options by clicking on Markup 
in the menu bar. There are keyboard 
shortcuts for common ones such as 
Strong (bold) or italics.

Create
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Move around the doc
In the Inspector panel, click on the 

middle “list” icon; you’ll see the Outline 
view shown here. This shows headings 
and subheadings; clicking on any of them 
will take you to that part of the document. 
It’s great for dissertations and reports.

Embrace the dark
Ulysses supports Dark Mode, but 

you can combine light and dark. Choose 
View > Appearance > Dark to make the 
Library and other panels dark, but don’t 
select View > Dark Theme so the editing 
window remains black on white.

Tap on the Export menu to see 
multiple choices — Open With Word, 

Attach To Mail creates an email with the 
document attached; Send as Mail puts 
your document in the message body.

Change the format
Let’s try PDF and then one of the 

styles: Business. The layout and fonts 
change, and there are tons of templates to 
choose from — reports, screenplays, 
academic documents — and you can 
download more from https://ulysses.app.

Change Everything

templates that change how Ulysses 
color–codes your docs. Some are high 
contrast, others are designed for coders, 
and still others just look nice. There are 
more available on the Ulysses website.

Switch your view
You can show or hide the Library 

and other panels by moving into 

Focus, which hides everything but the doc 
you’re working on. Full Screen view is 
particularly good on laptops.

Export the document

Share icon (top right), and you’ll see the 
Export screen. There are two options — the 
top line, where it says DOCX, enables you 

particular template.

Get more advanced
Ulysses isn’t just for text. You can 

add Word or Pages–style tables, insert 
images, add footnotes, embed video and 
use comments that can be accessed by 
other Ulysses users. You can also insert 
code and code blocks, lists and more.

Organize everything
Click View > Library to display your 

document library. You can organize 
documents into groups and subgroups, 
and drag docs appropriately. You can 

How to do anything on your Mac, iPhone & iPad
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Master Focus 
Filters across 
your devices
How to customize with Focus to  
enhance your productivity

REQUIRES
macOS 13 or later, or iOS/

YOU WILL LEARN
How Focus can streamline 

your day

IT WILL TAKE
15 minutes

HOW TO Use Apple’s handy Focus feature

Find your Focus
Focus lives in Settings on Mac, 

iPhone or iPad. We’ll start on Mac. As you 
can see, there are already three Focus 
modes available. Let’s create a new one. 
We’ll also enable the Share Across Devices 
toggle so our Focus modes are shared.

Make the rules
As you’ll see, there are several 

set a schedule, and even change how 
some apps behave. Let’s start with 

Choose your type
What kind of Focus would you like? 

Apple has some suggestions for you, but if 
none of them suit then you can click on 
Custom and make your own with your 
choice of title, icon and color. We’ll stick 
with the Work option for our new focus.

 
CARRIE MARSHALL

FOCUS MODES IN

Create
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Pick a trigger
You can set your Focus mode to 

switch on at a particular time, or use 

when you arrive at or leave a location. And 
you can also choose to activate it when 

Select a design
You’ll now see a selection of Home 

Screen designs that you can choose for 
this Focus mode. For example, we’ve got a 
very empty dark one for our Driving Focus 
and a much more colorful one for our 
Personal Focus.

Clear your Calendar
You can tell Calendar, and some 

calendar or calendars when your chosen 

the family calendar in a Personal Focus 
and your work one in a Work Focus.

people; oddly it doesn’t let you specify who 
from the Focus Filter screen. Enable the 

Save your screen
Once you’re happy with your 

design and your widgets, just tap on Done 
to save your Home Screen. The screen and 
widgets you’ve selected will now appear 

Focus mode is activated.

Edit your iPhone
When you share Focus modes, you 

can do additional things on your iPhone. 
Go into Settings > Focus and you should 
now see the Focus mode you created. Tap 
on it and you’ll see the screen here. We’re 
going to choose a Lock Screen.

Filter your email
Some apps, such as Mail, enable 

here we’re telling Mail that there’s only one 
email account we want to use in Work 
mode. This makes it easy to separate your 
personal and work emails.

Add your Widgets
Each Focus’s Home Screen can 

have its own font, color and image 
settings, and you can also choose the 
widgets you want to appear in your Focus 
mode — for example, a Driving Focus 
might have maps and weather widgets. 

You can even tell your device 
which Tab Group to open when a particular 
Focus mode is activated. That’s really 
useful if you tend to visit or refer to the 
same websites every day, or if you have 

How to do anything on your Mac, iPhone & iPad
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GENIUS TIP

 

Look sharp on every video
Get ready for your close–up with Hand Mirror for Mac

REQUIRES

YOU WILL LEARN
 

IT WILL TAKE

in your menu bar that, when clicked, opens 
a small window that previews your video 
feed. That lets you make sure everything is 
in order before you make that important 
sales pitch.

For $4.99, Hand Mirror unlocks a slate of 
extras, including custom window shapes and 
positions, more app icons, and a handy tool 
that opens the preview whenever you click 
the MacBook’s notch. It’s not necessary to 
shell out to enjoy Hand Mirror, but we’ll 
cover its paid–for extras in this tutorial.  
ALEX BLAKE

WITH THE ADVENT of the 
COVID–19 pandemic, we found 
ourselves doing a lot more video 
calls than we were used to. 

Suddenly, the prospect of appearing in front 
of friends and colleagues with wild hair and 
strange clothing choices became all too real. 
Video calls aren’t going away but, 
fortunately, there’s an app that enables you 
to check you’re still looking great before 
joining a call.

It’s called Hand Mirror, and it’s free to 
download. When installed, it places an icon 

HOW TO Set up Hand Mirror 

Select popover size
Open the preview popover and click “…”, 

followed by Settings > General. Here, you can pick 
a new icon from one of four choices, or set the 
popover’s size to small, medium, or large. You can 
also toggle Mirror Video.

Preview the output
Once you’ve installed Hand Mirror, click 

video output. This can be done whether or not 
your video app is open. Click “…” in the top–right 
corner to change the camera source.

Create

36    JUNE 2023 Image rights: Apple Inc, Rafa.Design.



Open a Smart Window
The in–app purchase unlocks extra tools. 

Click Settings > Hand Mirror Plus > Smart Window. 
Under Window Type, click Smart Window. Choose 
a screen position or click “Manual position” to 
move it where you want.

Discover extra app icons
The app’s free version has a choice of four 

app icons, but Hand Mirror Plus has many more. 
You can change the menu bar icon as well as the 
Dock icon. Additionally, you can show or hide the 
app icon in the Dock.

Choose shape and zoom
Click Window Mask. You can make the 

 
JARGON BUSTER

 
GENIUS TIP

 
 

 

Create a shortcut
In the General settings, click Record 

Shortcut to create a keyboard shortcut that will 
launch the Hand Mirror popover. Below, select an 
option next to Close Popover When to decide how 
the window is hidden from view.

Trigger the notch
If you’re using a recent MacBook, you can 

use the notch to launch Hand Mirror’s popover. 
Click Notch Trigger in the sidebar and enable it 
using the toggle. Now just click your MacBook’s 
notch and the popover will appear.

Work with multiple 
monitors

There are other options here. If you have two or 
more displays, you can choose which the popover 
appears on. You can also decide whether it 

How to do anything on your Mac, iPhone & iPad

JUNE 2023    37Image rights: Apple Inc, Rafa.Design.



Aim for the stars
Track the planets and learn the constellations with Night Sky 11

REQUIRES
Night Sky, iOS 14 or later, 

iPadOS 14 or later

YOU WILL LEARN
How to identify objects in 

IT WILL TAKE

the stars, letting you pick out all manner of 
objects — both natural and man–made — 

In fact, the app is so loaded with tools that 

but it’s worth exploring the app yourself 

of features included for free, but a Night 

ALEX BLAKE

STARTING A STARGAZING hobby 
from scratch can feel like 
tackling a truly unfathomable 

what’s what across the endless expanse of 

But that’s not so with Night Sky installed 

HOW TO Become a master stargazer

See the night sky
Open the app and start moving 

your device around. Night Sky will overlay 
constellations, satellites, planets and 
more. Tap an object for more info; tap 
Directions to be pointed back to your 
selection if you move away.

Colored overlays
Tap the ring button below the 

infrared light, microwaves, radio waves, 
and much more. There are eight overlay 
options to choose from.

Layer it up
Tap the layers button on the right 

You can remove everything except the 
constellations, for example, if you want 

without distractions.

Create
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Astrophotography
Pull up the bottom menu, then 

scroll down to Astrophotography and tap 
it. The left–hand menu lets you toggle 
photo/video mode, tweak focus and 
exposure, highlight star trails, and 

Grand Orrery
Scroll the premium menu and tap 

AR Grand Orrery. This puts an AR model of 
the solar system in your home. Drag two 

can show or hide stars, planetary paths, 
satellites and more.

Connected 
Stargazing

Swipe up for a menu of paid–for features. 

which lets you manually tag objects in the 
sky to create a tour, then enjoy it with your 
friends using FaceTime’s SharePlay.

Editors’ picks
Go back to the menu and tap 

follow the on–screen prompts to locate 

accompanied by useful information and 
fascinating facts.

Find the aurora
Finally, go back and tap Aurora 

northern lights. Move the map to view 
hotspots (coverage is highlighted 

move directly to it.

Live Sky Tour
Tap Live Sky Tour. Unlike the 

editors’ tours, live tours are based on your 

towards various celestial bodies, with info 
on each one. You can pick from short, 
medium, or long tours.

Sky Tags
Sky Tags let you save things for 

later. Tap and hold an object on–screen, 
then tap a color. You can add a name, 
notes, and photos to the tag, plus change 
its category and icon. Free accounts are 
limited to two Sky Tags.

Planetary Portals
Go back and tap AR Planetary 

Portals. Point your camera in front of 

planet from the list. The portal will now 
appear. Walk towards it to see the sky from 
that object’s surface.

Follow satellites

Live Satellites. This shows all the satellites 
orbiting our planet — rotate the globe to 
see more. Well–known objects such as the 
International Space Station and Hubble 
Space Telescope are highlighted in red.
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HomePod and HomePod mini contain temperature and 
humidity sensors, plus sound recognition — handy for those 
times when a smoke or carbon monoxide alarm goes off.

Do more with HomePod
 Discover how to tweak its settings, access hidden features and more

REQUIRES
A HomePod (second–gen)  

or HomePod mini,  
iOS/iPadOS 15

YOU WILL LEARN
How to do more with your 

HomePod mini or HomePod 
using your iPhone or iPad

IT WILL TAKE
 30 minutes

HOMEWARD BOUND
The best place to start is the Home app 
on your iPhone or iPad. Tap to select your 
HomePod mini or HomePod from its listing 
under Home > Home > Speakers & TVs, and 
you’ll be taken to that device’s options 
screen where you can set alarms, create 
automations and tweak various settings, 
including Siri. This is the place you also head 
to for updating your HomePod’s software. 
Let’s take a look… 

is not only a great–sounding 
speaker, but an incredibly smart 
one, thanks to built–in Siri and 

support for smart home protocols such as 
HomeKit, Thread and Matter.

The latest HomePod and HomePod mini 
can even take on some smart home duties 
themselves as both have built–in 
temperature and humidity sensors, enabling 
you to keep tabs on the health of your home. 
Both also include sound recognition, which 
enables them to alert you via your iPhone, 
iPad or Apple Watch should any of your 
home smoke or carbon monoxide alarms get 
triggered, which could prove invaluable.

Plus, the intelligent speakers can act as 
home hubs for other devices via HomeKit, 
enabling you to control all kinds of smart 
home devices from your iPhone, iPad, 
Mac, Apple Watch or Apple TV.

Since it’s not always obvious what the 
second–gen HomePod and HomePod mini 
can do, we’re going to take a deeper dive 
here to help you make the most of both.

 
GENIUS TIP

You can also use  
your Apple TV box to  

control your HomePod and  
display artwork and lyrics 

for the currently playing 
HomePod track.

Create
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HOW TO Make the most of your HomePod 

HomePod options
Once you’ve selected your 

HomePod in the Home app, you’ll see this 
screen, which enables you to view and 
control the currently playing track (if any), 
or choose from any recent albums or 
playlists you’ve been listening to.

Customize Siri 
Head back to the HomePod 

options screen then go to the Siri section. 
Here you can choose whether or not your 
HomePod listens for “Hey Siri” among 
other options. To have Siri recognize your 
voice, switch Personal Requests to On. 

Choose alarm sound
Tap Choose Media to either select 

a track from Apple Music or to choose from 
a range of ambient sounds, including 
Fireplace, Forest, Night and Ocean. To do 
that tap Ambient Sounds, select a sound, 
then tap Done.

Set a new alarm
Next, tap the clock at the top to 

choose an alarm time, then Repeat to 
choose when you’d like the alarm to be 
repeated (e.g. Every Monday). Next, 
choose an alarm sound — either Play Tone 
or Play Media. Let’s choose Play Media. 

Reset your HomePod
If your HomePod stops responding, 

head back to the main HomePod options 
screen, then scroll to the bottom and tap 
Reset HomePod. Alternative instructions 
for resetting your HomePod can be found 
at .

Set an automation
On the Add Automations screen 

are four options. Let’s tap People Leave. 
On the next screen you can choose 
Anyone Leaves, The Last Person Leaves, 
plus a Location/Time. Tap Time for “During 

Check alarms  
and timers

Scroll down to the Alarms and Timers 
sections to view any alarms you have set 
or any timers you have running. Use the 

Use the Intercom  
A fun option in HomePod settings 

is Intercom. Ensure it’s switched on, then 
go back to the Home app home screen. 
Tap the sound wave at the top–right to 
open the Intercom. This lets you send a 
voice message to others in your home. 

More options
Return to the HomePod options 

screen, then scroll down to Automations. 
Here, you can choose options like having 
the HomePod start up when you get home 

Automation to add one.
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In addition to the customization features in this tutorial, 
check out the extensive options in Settings > Accessibility.

Switch views on Apple Watch
 Watch faces aren’t the only way you can customize your Apple Watch

REQUIRES
An Apple Watch with 

watchOS 6 or later

YOU WILL LEARN
How to customize  
your Apple Watch

IT WILL TAKE
 10 minutes

more to discover in Settings > Accessibility 
than we’ve covered here.

Not all of the customization is available 
for every Watch — for example, you can 
disable Always On mode in Settings, but 
only if you have the Apple Watch Series 5 or 
later, as previous Watches didn’t have 
Always On displays — but the core features 
here apply to every model running watchOS 
6 or later. CARRIE MARSHALL

WATCHES ARE AMONG the most 
personal devices we own, and 
that means every Apple Watch 
owner will want something a 

Complications enable you to create all kinds 
of great combinations, with Apple’s own 
designs supplemented by Complications 
from Apple and third–party apps, but that’s 
not all you can customize. You can also 
change the way your Apple Watch displays 
your apps, how it responds to your 
movements, and what it does when you’re 
no longer interacting with an app.

Here, you’ll discover how to change the 
layout of your App View, and how to swap 
the Grid View for an easier–to–navigate List 
View. You’ll also discover how to tweak the 
Dock for quick access to your most 
important apps, how to make your Apple 
Watch display easier to read, and even ways 
to change how it wakes up.

NOT JUST A PRETTY FACE
We’ve also included some Accessibility 
features, which you can also use to change 
the way your Watch looks and works. If you 
have vision or mobility issues there’s even 

 
GENIUS TIP

Use your iPhone’s Shortcuts 
app to create custom 

automations for your Apple 
Watch. We use Shortcuts to 

change our Watch face at 
specific times.

Create
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HOW TO Personalize your Apple Watch behavior 

See your apps
By default, pressing the Digital 

Crown will take you to this screen. Each 
icon here is an app, and as you’d expect 
tapping the icon will then launch that app. 
Turn the Digital Crown to zoom in and out 
for a better view.

Change the behavior
In the same part of Settings, you 

can adjust how your Watch wakes up. If 
you don’t want it to wake when you raise 
your wrist or rotate the Digital Crown, turn 

how long your Watch should wake for.

Use the Dock
Press the side button (the long 

button below the Digital Crown) and you’ll 
be taken to the Dock, which is a scrollable 
selection of recently opened apps. Simply 
scroll to the one you want and tap it to 
open that app on your Apple Watch.

Navigate the list

decipher because of similar–looking app 

This provides a simple alphabetical list, 
which you move between by swiping up 
and down or turning the Digital Crown.

Explore Accessibility
As you’d expect from Apple, there 

are lots of good accessibility options in 
your Apple Watch settings, with visual 
options including improved on–screen 
contrast, reduced color, and reduced 
motion in apps and menus.

Adjust everything
In Settings > Display & Brightness, 

you can make more important changes to 
how your Apple Watch looks, including the 
brightness of the display, the default text 
size, and using bold text to make text in 
lists and apps easier to read. 

Move them around
If you long–press an app icon, 

and Edit Apps. Select Edit Apps and you 
can slide the icons around to reorder them 
or remove some altogether.

Turn back the clock
In Settings you can change how 

your Apple Watch behaves in apps; by 
default, it will return to the Watch Face 
after two minutes of inactivity, but you can 

Swap the Dock
If you’d rather see the same list 

Settings > Dock, and tap Favorites instead 

as favorites.
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VR headsets
With rumors of Apple entering the arena, we explore current VR technology

But, amidst all these swirling rumors, 
there does seem to be a consensus 
emerging. There are more and more reports 
of Apple preparing to launch a VR headset 
that will be called the Reality Pro, and it’s 
likely to be announced at Apple’s Worldwide 
Developer Conference (WWDC) in June. The 
“Pro” bit is important, as it seems that 

cost as much as $3,000, and will very much 
be aimed at professional users, such as game 
developers, architects and engineers, who 
need the ability to work in 3D virtual 
environments. So, while we wait for the 
latest batch of rumors, here’s an overview of 
the current state of VR technology and what 
we might expect from Apple.

We all know what a VR headset is supposed 
to look like — a bulky, wrap–around device 
that straps onto your head and completely 
covers your eyes. The front part of the 
headset generally houses a pair of high–
resolution screens — one for each eye — to 

fall into two main categories: those that 

 than a decade 

iPad back in 2010, and although 
Apple has introduced new 

products since then, such as the HomePod 
and Apple Watch, many people are waiting 
eagerly for “the next big thing” that will 
take the company into entirely new 
territory. A few years ago the rumor mill was 
eagerly looking forward to an Apple Car, but 
the zeitgeist has now moved on and there’s 
an absolute frenzy of speculation about a 
new virtual reality (VR) headset that will 
take Apple into the brave new world(s) of 

that it’s hard to keep up. A couple of years 
ago, there was talk of Apple Glass: high–
tech spectacles, similar to the ill–fated 
Google Glass. Then, as the entire tech 
industry went crazy for the metaverse, the 

reality (VR) headset that would be capable of 
depicting immersive virtual worlds with 
slick 3D graphics. Along the way there have 
also been rumors that Apple was opting for a 
simpler augmented reality (AR) or mixed 
reality (MR) headset. 

Create
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YOU WILL LEARN
How VR headsets work, and 

how Apple’s rumored 
offering might compare to 

what’s already available

KEY FACT

Augmented reality (AR) — 
sometimes referred to as 
mixed reality (MR) — isn’t 

the same as true VR. Rather 
than creating an entire 3D 

virtual world, AR/MR glasses 
or headsets superimpose 

computer graphics over the 
real world that you see all 
around you. That’s already 
possible using games like 

Pokémon Go, which displays 



> 

KEY FACT

Most keen Apple watchers 
agree that Apple is working 
on an expensive headset 
called Reality Pro, that will 
be aimed at professional 
users. However, there are 
also reports of VR health 
and fitness apps being 
developed at Apple too. 
That’s quite likely, given 
Apple’s focus on fitness 
with the Apple Watch, so it 
could mean that there’s a 
more affordable headset in 

 

A VR headset can show you all sorts of 
amazing virtual worlds, but that’s not 
much use if you’re simply a passive 
observer — like watching a 3D movie 

of interacting with the virtual world 
around you, whether you’re a doctor 

striking your enemy with a sword in 

A key technology here is called 
“tracking”, as it uses cameras and 

other 
sensors to 
follow the 
movement 
of your 
hands and body 
while you’re moving around in your 3D 
world. Some headsets have cameras 
built into them for tracking, while 
others use external sensors, such as 

Index, which have to be placed in the 
room around you.

Apple seems to be tackling this 

ways. It’s known that Apple has applied 
for patents for devices such as VR 
“gloves”, but a recent rumor suggests a 
simpler option, with the ability to use 

device within VR apps and games.

have to be connected to a powerful PC or 
games console, and those that can act as 
standalone devices that have their own 
processor for running apps and games.

Sony’s new PSVR 2 (from $549.99) is 

consoles. The headset doesn’t work on its 
own, so you’ll need to own a PS5 in order to 
run your VR games and then use a simple 
cable to connect the headset to the console. 
Sony claims that the PSVR 2 provides “4K 
video”, but it’s actually 2K per eye, with two 
screens that provide 2,000 x 2,040 
resolution for each eye. 

The Valve Index — a VR kit by the 
developers behind the Steam store and 
Half–Life games — works in a similar 
fashion, but instead relies on a powerful PC 
for running Windows games. The Index is 
very much aimed at hardcore gamers, and 
costs a hefty $999 for a complete kit with a 
headset, handheld controllers, and base 
station control hub. It uses lower resolution 
screens — 1,440 x 1,600 for each eye — but, 
like many high–end gaming monitors, the 
screens have a 120Hz refresh rate that helps 
to reduce eye strain and provide smoother 
movement for 3D graphics.

The other approach to immersive gaming 
is to use a standalone VR headset that is 
capable of running games and apps on its 
own, without being connected to a console 
or PC. That’s the approach taken by the 
recently released Meta Quest 2, developed 
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by Facebook parent company, Meta. The 

headsets, costing $399. It uses two 
screens that each have 1,832 x 
1,920 resolution, but the Quest 2 is 
also powered by a Qualcomm 
Snapdragon processor — the sort 
that is used in many Android 
smartphones and tablets — so it can 
run games and apps on its own without 
needing a PC or games console (although, 
there’s an optional Link cable that allows 
you to connect the Quest 2 to a PC so that 
you can run Windows games if you want to).

Meta also makes a “Pro” version of its 
headset, which costs $999, and there are 
other companies, including Hewlett–
Packard with its Reverb headset, that now 
make high–end alternatives for professional 

and architecture.
As mentioned, the rumors surrounding 

Apple’s Reality Pro headset suggest that this 
will also be a high–end headset aimed — 
initially at least — at professional users. It 
also looks likely that Apple’s headset will be 
powered by an M2 processor and a new 
operating system called xrOS (extended 
reality OS), that has the ability to switch 
between VR and AR modes. The only thing 
that the rumors seem to agree on is that the 
headset will be announced sometime in 

changing technological innovation. 

All VR headsets also need some sort of  
controller that will allow you to interact with  

the virtual world around you.



Our resident genius  
Howard Oakley solves  
your Mac and iOS problems

EXPERT 
ADVICE

TECH SUPPORT & TECHSPLANATIONS

You can work fully in either type of 

in privileges; users with Admin accounts 
can do almost everything, although for 
some actions like changing the main 
Library folder, and upgrading macOS, 
they’re prompted to enter their 
password. They can also create and 
remove user accounts. Standard users 
can install apps, but for actions requiring 

Admin user’s name and password. 

more comfortable, as it can prevent 
errors. Whether it’s any more secure 
depends on your behavior, and how 

details. If that’s frequent, it could 
become automatic, and the Standard 
user’s protections may vanish. If you rely 
on being a Standard user to protect from 
phishing or malware, then you could 
drop your guard, and succumb to an 
attack for your Admin user’s name and 
password after all.

Apple supports Standard users, but 
doesn’t explicitly recommend that you 
should normally work as a Standard user. 
So the choice is yours, and depends on 
which you’re happy with.

> Should I be a Standard or Admin user?

Changing Background Items
WHEN DID YOU last check 
the .plists in the 
LaunchAgents and 

LaunchDaemons folders in your 
Mac’s main Library folder? Most of 
us leave them well alone, although 
some are old and few have clear 
excuses for being there. One of 
Ventura’s less publicized changes 

gives visibility and control to them 
in the list of Background Items in 
the Login Items settings. Not only 
should this improve stability, but 
in the long run it should 
also prevent malware from 
persisting in the background by 
abusing those .plists. The goal is 

each app, where they will be 
protected by its signature, and safe 
from tampering by unwanted 
visitors. Achieving that will take 
time, though, as developers will 
need to update their apps in order 
to take advantage of this new 
scheme, and make them more 
self–contained.

If you’re more comfortable working as a 
Standard user, add one using Users & Groups 

settings, after the primary Admin account.
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Switch to Advanced Data Protection only if you need 

Quick–fire 
questions  
& answers
HOW TO ENSURE 
APPS AND  
SITES AREN’T 
TRACKING ME?
To check which apps 
are allowed to track, 
look in Settings > 
Privacy & Security > 
Tracking. Preventing 
websites from tracking 
requires you to use 
either a VPN service, or 
an iCloud+ account 
with Settings > Apple ID 
> iCloud > Private Relay 
turned on.

HOW TO USE A 
DVORAK KEYBOARD 

iPHONE?
Most keyboards offer a 
choice of several 
different layouts in 
Settings > General > 
Keyboard > Keyboards > 
[keyboard name], which 
might well include 
Dvorak, French AZERTY 
and central European 
QWERTZ in addition to 
the standard QWERTY. 
These are most helpful 
when you normally 
work in a different 
language with its own 
non–QWERTY layout.

 

> Standard or Advanced Data Protection?

For most this comes down to whether its 

you want Apple to be able to recover your 
data should you lose access to your 

switch all your Apple devices and Macs to 
this new service.

by iCloud and iCloud+, all the more 
private data is already fully protected 
using end–to–end encryption. This 

passwords, health data, cards and 
payment information. Advanced Data 
Protection adds backups, Photos, 
Notes, the contents of your iCloud 
Drive, and some other categories. The 

the encryption keys for those unless 
you opt for this additional protection.

keys is that, should you lose access to 
your account, it can recover the data 

those keys, and you’d need to recover 
data using a contact or personal 
recovery key, or a device passcode.

The major obstacle for most users 
is that Advanced Data Protection is 

devices or Macs running iOS 

able to convert your account to the 
advanced version. Even if that 
device hasn’t been active for years, if 

information is at https://apple.co/3IgI0fR.
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Quick–fire 
questions  
& answers
HOW TO USE MY iMAC 
5K 2017 AS AN 
EXTERNAL DISPLAY?
Your iMac is too recent 
to be run as a target 
display (see 

). The 
only way to use it as a 
display is through 
AirPlay Display in 
Monterey and later, 
which probably isn’t 
what you had in mind.

WHAT DO I NEED 
 iPHONE 

AS A WEBCAM?
Your host Mac must be 
running Ventura and 
signed in to the same 
Apple ID with two–
factor authentication 
(2FA). Your iPhone must 
be an XR or more recent 

Mac. A mount isn’t 
required. Both need 
Wi–Fi and Bluetooth, 
and not sharing mobile 

Network Attached Storage (NAS) systems use 

used by Macs. To store Time Machine backups 

storing the virtual disk in a great many “band” 

sparse bundle looks just like a disk, in this 

bundles have normally functioned well until 

they may suddenly stop working. Failure has 
been associated with very large numbers of 

Machine has therefore improved its creation 

and management to reduce the risk of failure 
in APFS backup storage inside sparse bundles, 
setting their size to keep the number of band 

Each time that Time Machine mounts 
 

it’s checked thoroughly to ensure it’s  
healthy. This is just as well, as attempts  
to repair damaged sparse bundles seldom 
succeed, and once broken they can’t even  
be mounted to recover their contents.  
If you’re storing a backup sparse bundle  
on hard drives, it’s wise to mirror them for 
safety. But you shouldn’t have to perform 
additional integrity checks of their sparse 
bundle, as that’s done by macOS. 

> Checking NAS backups

Backups stored on hard drives in a NAS are automatically checked, but still need mirroring to protect from drive errors.

Peripherals
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Quick–fire 
questions  
& answers

 

APFS still results 

fragmentation reducing 
performance of hard 
drives. If your library 
grows slowly this may 
not be noticeable, 

better when possible.

CAN I USE A 
SECURITY KEY  
FOR TOUCH ID?
No. Security key 
support added to 

authentication (2FA) for 
your Apple ID to iCloud. 
Touch ID requires 
built–in key support, 
and on Apple silicon 
with an Apple keyboard.

our review in #205) spares a port on 

performance of those two SSDs 

simultaneously. With the hub 

throughput to all drives connected 

the maximum for a single Thunderbolt 

sec. When reading from both drives 

otherwise fast SSDs can show more 
limited write speeds than you would 

their performance. The only way to 

unlikely to be accessing both SSDs at 

connected to a notebook powered 

Satechi’s also support pass–through 

you another of its ports.

> Thunderbolt direct or via a hub?
 

Total data throughput to SSDs connected to a Thunderbolt 4 hub can’t exceed the 3GB/sec of a single Thunderbolt port.

When display problems strike, 

swapping it for a known good one 
before trying anything else.

> Display waking up a mess
 

There are plenty of reports of similar  

(Ventura), but before accepting that as the 
cause, you should check that the cable you’re 
using is good, and that there’s no problem with 
your Mac’s hardware.

One test is to run hardware diagnostics 
from Recovery mode. Start your Mac up while 
holding the Power button until it announces 
that it’s loading Startup Options. Once that has 

loaded, press and hold the Cmd+D keys until 
your Mac restarts and shows the Diagnostics 
Loader, then follow the instructions.

In some cases, it may be worth  
making an appointment at your nearest  
Apple store for them to run their more 
extensive tests. If your MacBook Pro is  
healthy and the cable is good, keep up  
with Ventura’s updates in the hope that  
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macOS
 

install correctly, start your Mac up in safe 

Shift key held; on an Apple silicon model, 
start it up with the Power key held until 
it’s loading Startup Options, then select its 
disk, hold the Shift key and click on the 
Continue in Safe Mode button. Open 
Software Update again and try to update.

If that still fails to resolve the issues, 
you’ll have to resort to ensuring that 

you’ve got full recent backups, and 
instead start up in recovery mode and 
reinstall macOS there.

> Break a macOS update loop

This problem should at least ease with the update to 
Ventura 13.3. Any that continue after that are probably 

removed. If you can’t identify the culprit from info in 

with the Terminal command:

and entering your admin password. That writes an 

text in your Documents folder.

the remains of old apps and update others.

Start up Apple silicon Macs in safe mode through Recovery; 
select the disk, hold Shift and click on the button.

If all else fails, ensure you’ve  
got a full recent backup and reinstall 

macOS in Recovery mode.

Background items 
listed often aren’t 

unless you get a 
list dumped into a 
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These problems aren’t common and can be 
hard to resolve. First ensure macOS is fully 
updated, preferably to the current release of 
Ventura, then make a note of which apps and 
settings you’re being asked to restore. If these 

them and install their latest versions afresh.
Persisting problems should take you to 

those entries in the categories shown in 
Privacy & Security settings, or the Privacy 
pane in Security & Privacy in System 

remove it from the list. Restart your Mac, open 
those settings again and click “+” to add each 
of those apps back to the list, and ensure 

they’re enabled too. They should also appear in 

access. If needed, you can reset the privacy 
databases altogether, using the tccutil 
command tool in Terminal, but that will blow 
away all your existing privacy settings, apart 
from those for Location Services. The 
command to use is:

seconds later, check through the categories 
apart from Location Services and manually 
remove any remaining. If problems recur after 
that, some recommend deleting the privacy 
database, but without knowing the cause, you 
could have to keep repeating that.

> Broken privacy settings

EMAIL: ask@maclife.com 
FACEBOOK: facebook.com/maclife  TWITTER: twitter.com/maclifeSHARE WITH US!

HOW TO STOP STAGE MANAGER  
FROM STALLING ON HELP?
Stage Manager can stop responding  
when you click the yellow minimize button  

 
silicon Mac. This is a bug, and the best way  
to recover is to disable Stage Manager in  

 
and re–enable Stage Manager.

HOW TO EXTRACT TEXT FROM  
AN IMAGE QUICKLY?
macOS Ventura supports extraction of text 
from images with Live Text in apps like Safari 
and Preview, as well as QuickLook previews. 
Select the image in the Finder and press the 
Space bar for a preview. When the text icon 

to select all recognized text.

Quick–fire 
questions  
& answers
HOW TO STOP THE 

The log can’t be 
disabled, and is 
maintained so that its 
files occupy a steady 

volume of the active 
boot volume group. It 
shouldn’t grow much 
beyond that, and its 
turnover is insignificant 
in wear on your 

PARTY DISK REPAIR 

There are currently no 
third–party tools, other 
than some for low–level 

now runs on both Intel 
and Apple silicon 
models, and can repair 

volumes, not APFS.

When you add apps to the 
Full Disk Access list in 
Privacy & Security settings, 
they’re also automatically 
added to Files and Folders.
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 S
pring has sprung, and it’s 
that time of year when many 
of us start to think about 
summer and the great 
outdoors. Warmer weather, 

longer days, and stunning scenery draw 
us from the confines of our homes into 
the fresh air. For some of us, that means 

veg, or just enjoying the space. For 
others, it means hitting the road and 

exploring, or even adventuring to a  
far–flung land. Whatever your preference 
for spending time outside, there’s a 
gadget or ten that will make the 
experience more fun, more relaxing, and 
safer too. It may be a projector so you 
can create your own outdoor movie 
theater in the backyard, a robotic lawn 
mower so you can put your feet up rather 
than throw your back out, or a bag 

We’ve focused on the latest gear and 
on tech you can use with your Apple 
device. But we’ve also included a few 
gadgets that don’t plug in to your Mac, 
or have an accompanying app for your 
iPhone or iPad, just because they’re great 
pieces of technology that are either fun, 
useful or both. So, whether you want to 
relax at home, or hit a mountain bike trail, 

with you outside. 

Tech for the great outdoors
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 Even if it’s 

JBL Charge 5
>  $179.95  

>  www.jbl.com
A great Bluetooth speaker for the 
outdoors. Waterproof and dust–proof 
to IP67, the JBL Charge 5 also has 20 
hours of playing time and you can pair 
two for stereo sound. Better still, it 
doubles as a power bank.

Weber Spirit 
SX–315

>  $869
>  www.weber.com
Weber makes every type of barbecue 
imaginable. But this one gets our vote 
because it has a digital display that 
shows you the current temperature 
and a countdown timer. There’s also a 
convenient app that alerts you when 
your food is ready.

Backyard
The top tech for growing, 
guarding and grilling

Philips  
Calla Outdoor 

bollard
>  $129.99  
>  www.philips-hue.com
This bollard lamp can glow white or 
you can pick from any one of 16 
million colors. It’s weather–proof to 
IP65 and you can control it from your 
Apple device using HomeKit.

Meater Plus
>  $99.95  

>  https://store-us.meater.com
This wireless thermometer measures 
both the temperature of your food and 
the ambient temperature. It connects 
to an iPhone app via Bluetooth and will 
tell you how long your BBQ meat has 
left before it’s ready.

BenQ GS50
>  $749 

>  www.benq.com
This portable 1080p DLP projector has 

subwoofer. It’s also drop–proof and 

your MacBook via HDMI or USB–C, 

outdoor theater experience.

54    JUNE 2023

Feature

Image rights: Weber, Apption Labs, Harman Intl Ind, Signify Holding, BenQ Corp.

https://www.philips-hue.com/en-gb
https://www.benq.eu/en-uk/index.html
http://www.jbl.com
http://www.weber.com
https://store-us.meater.com


Husqvarna 
Automower 

115H (4G)
> $699.99
> www.husqvarna.com
Keep your yard neat with this robotic 
lawn mower that covers up to 0.4 
acres and can be controlled via an iOS 
app. Set a schedule and program 
some start points, then relax and let 
the mower do the rest.

Eve Aqua
> $149.95

> www.evehome.com
This smart irrigation device will make 
sure your lawn is watered 
automatically. Just hook it up and set 

connect the Aqua to your HomePod or 
Apple TV for watering your lawn when 
you’re away from home.

S300 eufyCam 
(3C)

> $469.99 
> https://us.eufy.com
This two–camera 4K security system 
comes with a base station and its  
own local storage, so there’s no 
monthly subscription for storing 
footage. Its battery lasts six months 
and it has spotlights and facial  
recognition technology.

Moft iPad  
Stand & Case

> $59.99 
> www.moft.us
If you’re taking your iPad into the yard, 
you’ll need a way of propping it up 
while you work, read, or watch a 
movie. This Moft case with its built–in, 
adjustable stand does just that and 
offers three modes, including 
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 Whether your 
preferred

On the road
The ultimate kit list for hitting the highways  

Mosiso MacBook  
Air case

>  $15.99 
>  www.imosiso.com
This protective hard shell case comes 
in multiple colors and, as well as 
protecting your MacBook Air from 
scratches and chips, includes a 
keyboard cover, screen protector and 
a separate bag for storing your mouse 
and earphones.

Peak Design 
Universal  

Bar Mount
>  $49.95 
>  www.peakdesign.com
Strap this iPhone mount to your 
bicycle or motorcycle and use it with 
Peak Design’s iPhone case to keep 
your iPhone secure and visible. The 
magnetic lock means there’s no risk of 
it falling off while you ride.

Nulock 
Bluetooth Lock

>  From $35 
> https://nuvending.com
This Bluetooth lock can be used to 
lock up a motorcycle, bicycle, or even 
a gate. It can be locked and unlocked 
via the iOS app, and has a tamper 
alarm to deter thieves that triggers 

disassemble it. 

Thinkware 
Dashcam 

F200 Pro
>  $139.99 
>  www.thinkware.com
This 1080p dashboard camera has 
night vision and a time–lapse mode, 

your iPhone. There’s a parking mode 
and the optional GPS antenna enables 
it to warn you of speed cameras, too.

EcoFlow River  
2 Max Portable 

Power Station
>  $469 
>  https://us.ecoflow.com
If your adventure is taking you off–
grid, you’ll need to take your own 
power supply. This one has up to 
512Wh, which is plenty to charge your 
iPhone or MacBook and power a 

guitar amplifier.
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Chrome 
Industries 

Citizen  
Messenger Bag
>  $160 
>  https://bit.ly/3B8G71L
Perfect for commuting, this bag has a 
quick–release buckle (with bottle 
opener). It’s water–resistant, has wet/
dry compartments, reflective 

Asus ZenScreen 
MB16AHG 

portable monitor 
>  $279 
>  www.asus.com
This 15.6–inch portable monitor from 
Asus weighs just 2lbs and gives your 
Mac more screen real estate. Its crisp 
1920x1080 IPS display boasts a 144Hz 
refresh rate, and it features 2x USB–C 
ports for easy connectivity.

Jabra Elite 7 
Active

>  $179.99 
>  www.jabra.com
These Bluetooth 5.2 earbuds are 
specially designed to fit snugly in your 
ear so they stay in while you’re 
working out. You can listen for up to 
eight hours and active noise 
cancellation enables you to shut out 
the outside world.

Satechi Pro  
Hub Max

>  $99.99 
>  https://satechi.net
Connecting to both Thunderbolt ports 

Satechi hub supports the full 40Gbps 
from each port, supports 96W 
charging, and has an SD and microSD 

simple plug–and–play setup.
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 We all have 

Vacations and excursions
Get away from it all… apart from your all–important tech  

DJI Mini 3
>  $559 
>  www.dji.com
DJI’s Mini 3 is the latest addition to its 
drone fleet. It’s ultra–lightweight at 
just 8.7oz, offers 38 minutes of flying 
time, and can shoot 4K and 30fps. Its 
f1.7 aperture, 1/1.3in CMOS sensor and 
HDR enable you to capture eye–
popping video.

OtterBox Fre 
Series for 

MagSafe
>  $99.95 
>  www.otterbox.com
This iPhone 14 case offers enhanced 
drop protection, a screen protector, 
port covers, and is waterproof for up 
to an hour at 2m (6.6ft) deep. It also 
has MagSafe magnets and is made 
from 50 per cent recycled plastic.

Osprey Ozone 
Laptop 

Backpack 28l
>  $170 
>  www.osprey.com

sleeve that will fit a 16–inch MacBook 
Pro, a separate compartment for 
cables and other gear, and a smaller 
pocket for your iPhone. It also comes 
with a Travel Sentry ID tag.

Peak Design 
Field Pouch V2

>  $49.95 
>  www.peakdesign.com
With two functions in one, roll down 

small enough to throw in a backpack. 

and zip pockets, and enough space for 
a camera.

Campstove 2+
>  $149.95 

>  www.bioliteenergy.com

sticks and when you start the fire, not 
only will you keep warm, but the clever 
stove will capture the heat, charge its 
3,200mAh battery, and charge your 
iPhone from a USB slot.
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GoPro  
Hero11 Black

>  $424.98 
>  https://gopro.com
The latest Hero shoots 5.3K video 
at 60fps and can capture stills at 
27 megapixels. It’s waterproof to 
33 feet and features GoPro’s 
HyperSmooth stabilization. At the 
price listed here, you also get a 
year’s GoPro subscription.

Bose 
QuietComfort 45

>  $329
>  www.bose.com
If you prefer over–the–ear headphones to 
earbuds, these active–noise–canceling 
cans from Bose are hard to beat. 
You get 22 hours of listening on 
one charge, adjustable EQ, 
and can connect  
two devices 
simultaneously.

Mophie 
Powerstation XL

>  $59.95
>  www.zagg.com
Powerbank expert Mophie’s latest 
charger has one 20W USB–C port and 
two USB–A ports, powered by a 

three devices simultaneously, 

DJI 
Osmo 

Mobile 6
>  $159
>  www.dji.com

DJI’s latest gimbal features 
three–axis stabilization, an 
extension rod and a tripod. 
A press of a button in the 
handle flips your iPhone 
from landscape to 
portrait, or control its 

rotation with  
a joystick.

THE BEST 
APPS FOR 
OUTDOORS
What3Words
> Free
> https://what3words.com

It’s a simple but brilliant 
idea. Split the world into 

3m  (9.8ft) square zones and 
identify each with a three–

to see which zone you’re in, 
even if you’re offline, navigate, 

AllTrails
>  $35.99
>  www.alltrails.com

Whether you’re hiking, 
cycling, or walking your 

dog, AllTrails allows you to 
discover trails to suit your 
activity.  You can download 
offline maps to navigate to 
your destination confidently, 
get live route details, log your 
activities to share later with 
friends, and much more.

Weather
>  Free
>  https://apps.apple.com

It’s wise to check the 
weather forecast 

before heading outdoors, and 
Apple’s Weather app is packed 
with useful data,  such as an 
hourly forecast, localised rain 
prediction, and a UV  index, so 
you know when it’s time to 
apply the sun screen.

Komoot
>  Free (with IAPs)
>  www.komoot.com

Komoot does a lot more 
than just help you plan 

hiking, cycling or mountain 
biking trips. It enables you to 
create and share guides, 
including photos. And, in turn, 
allows you to be inspired by 
other people’s guides.
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THE ULTIMATE GUIDE TO

Give your iPhone a whole new  
look — we show you how

WRITTEN BY ALEX BLAKE

ho needs defaults? 
One of the best things 

much customization it offers 
over how your Home Screen 
and Lock Screen look and feel. 
Your iPhone’s built–in features 
go way beyond simply changing 
your wallpaper and calling it a 
day. Take a look under the hood 

For example, in iOS 16 you 
can place small widgets on your 

your activity rings, upcoming 
reminders, and much more. 
There are toggles to change 
Lock Screen fonts, wallpaper 
colors, gradients and effects, 
and even add wallpapers that 
sparkle with beautiful animated 
effects or show the weather in 
real time.

That’s not all. You can also 
create custom Home Screens 
and Lock Screens that activate 
when you launch a specific 
Focus mode, saving you the 
time and hassle of manually 
setting everything up each 

time. There are oodles of 
options available, enabling 

 
that’s tailor–made to your 
specific requirements and 
personal to you.

To get all this to work, 

compatible. Home Screen 
widgets require iOS 14 or later, 
while Focus mode needs iOS 
15. For Lock Screen widgets, it’s 
iOS 16. (Note: the depth effect 
described on pages 62 and 63 
requires an iPhone XR or later.) 
Let’s dive in.

W
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You can link your Home Screen and Lock 
Screen or customize them separately.

Add a new screen
Tap and hold your Lock Screen and add 

a new screen by scrolling all the way to the 
right, then tapping “+” below Add New. 
Choose a Lock Screen style — there are 
screens with photos, colors, emoji and 
more — and tap it to begin.

Date widget
Tap the date at the top to open a 

widget list. You can scroll through any app 
that supports widgets below. Apple’s 
Weather app can display the weather at 
your location, moon cycles, wind speeds 
and more, for instance.

Secondary widgets
Below the time is an area for smaller 

widgets. Tap a widget (or tap Add Widgets if 
the area is empty), then tap an option to 
add it to the Lock Screen. You can drag 
widgets to this area or rearrange them into 
a new order.

HHHHOOOOWWWWW TTTTTO Add Lock Screen widgets

djusting your Home and Lock 
Screens is easy: just tap and hold on 
your Lock Screen then tap Customize. 

Next, tap either Lock Screen or Home Screen 
and you’ll see various options, from adding new 

You can use different wallpapers when your 
iPhone is locked and unlocked, tweak 
everything from fonts to colors, and much 
more. We’ll show you how it’s all done.

Design a Home Screen that 
works perfectly for you

A

MOVE OR 
SCALE
You can move or 
rescale the 
wallpaper by 
pinching your 
fingers together  
or apart.

SWIPE FOR 
EFFECTS
Swipe left or right or 
tap the dots to apply 
a color effect to your 
wallpaper.

CHANGE IT UP
 Change your 

wallpaper or apply a 
depth effect by 
tapping the buttons 
in the bottom 
corners.

WIDGETS
Widgets live at the 
top of your Lock 
Screen. Tap one to 
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HHHHOOOOWWWWW TTTTTO Change up the font

HHHHOOOOWWWWW TTTTTO Use animations and photos

HHHHOOOOWWWWW TTTTTO Tweak the Home Screen

Fonts and colors
When editing a Lock Screen, tap the 

time to alter the font it uses. There are eight 
fonts to choose from, plus various colors. 
Font changes only apply to the time  
widget, but color tweaks affect every 
widget’s text.

Switch themes
Touch and hold your Lock Screen to 

see your existing screens. Changing your 
theme is as simple as swiping between 
them and tapping a new choice. Or you can 
swipe up and tap the trash can icon to 
delete a theme entirely.

Change the photo
Touch and hold the Lock Screen and 

tap Customize > Home Screen. You’ll see a 
preview of the Home Screen, along with 
options at the bottom. Tap Photo if you 
want to choose a different wallpaper than 
the one used on your Lock Screen.

Digit scripts
In the font and color menu, tap 

different display script for the time on your 
Lock Screen. At the time of writing, the 
choices were Arabic, Arabic Indic, 

Animated wallpapers
Touch and hold your Lock Screen to 

add a new screen. The wallpaper gallery 
contains a few interactive options. Tap 
Weather to see an animated view of your 
forecast, or tap Astronomy to see the moon 
or your location on Earth.

Color or gradient

then tap your Home Screen. At the bottom, 
tap either Color or Gradient, then tap the “+” 
to change the hue. You can pick from  

 
using the slider.

Theme fonts
Some Lock Screen themes change 

the font and the overlay effect at the same 
time when you swipe left or right. These 
pre–made combinations are handy, but you 

tapping the time.

Depth effects
After adding a photo wallpaper, tap 

the “…” icon (bottom right) to add a depth 

time (you might need to remove widgets 

apply colorful effects.

Pair wallpapers
On the same screen, tap Pair to 

match the Home Screen background to the 
Lock Screen one. If they are paired, you can 
tap Blur to cloud the wallpaper. This could 
help your Home Screen apps and widgets 
stand out a bit more.
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Pick a Focus mode
You can link a Lock Screen to a Focus

mode so the former can enable the latter
(or vice versa). First, open Settings and
tap Focus, then create a Focus mode.
Alternatively, you might want to just
use one of the default modes.

Create a link
Touch and hold the Lock Screen

and tap Focus. A pop–up will appear with
your Focus modes listed. Tap one to link
it to your chosen Lock Screen; this Focus
mode will now start whenever the
selected Lock Screen is active.

Add some widgets
You can add widgets that will be

helpful for your chosen Focus mode,
such as a Google Maps widget showing

or a Calendar widget with the day’s
events in your work Focus mode.

HHHHOOOOWWWWW TTTTTO Use Focus modes from the Lock Screen

ot everyone knows that you can 
link a Home Screen or Lock Screen 

create custom screens that contain just 
what you need to focus and, in the case of 

themselves automatically without you 

judicious widget stacks and you’ll be  
ready to go.

Cut out distractions  
with these handy tools

N



Customizing your Home Screen
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First, save an iOS icon pack to your iPhone —  
there are plenty of free or paid–for options online.  
Now open Shortcuts and tap the “+” button,  
then tap Add Action > Scripting > Open App.  
Tap App and pick the app you want to open.  
Now tap the Share icon, tap Add to Home Screen  
and give the shortcut a name. Tap the icon and  

Finally, tap Add, then Done.

CCCreeaateee cussttoomm apppp 
icccoonss wwitthh SShhoorrtccuuts

HHHHOOOOWWWWW TTTTTO Hide Home Screen apps and pages

Customize Screens
In the Settings app, tap Focus and pick 

a Focus mode. You’ll see a Customize 
Screens section. The left image here 

Mode, while the right image is for an Apple 
Watch (if available).

Widget stacks
If you hide Home Screen pages in a 

Focus mode, you can still access your 
favorite widgets using widget stacks. These 
let you scroll between apps within a single 
widget, and are great for saving space and 
reducing clutter.

Hide some pages
Tap the middle option to tweak your 

Home Screen while the chosen Focus 
mode is active. Tap the pages you want to 
show and a tick appears below them. Any 
pages not selected will be hidden when 
your device is in this Focus mode.

Merge two widgets
Touch and hold your unlocked 

iPhone’s background, then tap the “+” (top 
left). Add two widgets to your Home 
Screen. You can drop the second widget on 
to the first one (providing they’re the same 
size) to create a widget stack.

Add new pages
Some Focus modes let you add new 

pages with suggested apps/widgets. Tap a 
page, then Edit Apps to change what 
appears. Tap Add to create the page. Tap 
Options if you want to hide notification 
badges on Home Screen apps.

Keep customizing
You can swipe up or down on the 

widget to scroll through the app widgets it 
contains. Add as many widgets to the stack 

Stack widget filled with widgets from apps 
you regularly use.

HHHHOOOOWWWWW TTTTTO Create multi–layered widget stacks



Rotate the frame 
counterclockwise and  
the built–in privacy  
shutter closes.

Razer Kiyo Pro Ultra
A 4K camera with a huge catch
$299.99  From www.razer.com

Features 4K resolution at 30Hz, 1080p resolution at 60Hz, autofocus, 82–degree field of view, 
8.3MP output, 1/1.2–inch Sony Starvis 2 sensor, f/1.7 aperture lens, privacy cover,  
built–in privacy shutter, USB–C to USB–A cable

excellent, and our resolution settings did 
indeed persist on macOS. But doing things this 
way is not an option for everyone.

That all makes the Kiyo Pro Ultra a very hard 
sell. It’s a shame, because the hardware inside 
is very good. Its output is close to matching 
Continuity Camera using an iPhone 12 Pro in all 
manner of lighting conditions, although the 
iPhone was a little less washed out and had a 
wider viewing angle (your mileage will vary 
based on the iPhone you’re using).

A FATALLY FLAWED PRODUCT
Right now, recommending the Razer Kiyo Pro 
Ultra is tough. You’ll need Camo Studio or a 
Windows PC to unlock its 4K resolution, which 
isn’t ideal. It’s a real letdown considering how 
solid the webcam is and how impressive the 
footage is once it’s adjusted. But if you just 
have a Mac or don’t want to pay for Camo 
Studio, the Kiyo Pro Ultra won’t be right for you.

In the meantime, try Continuity Camera. 
Provided you have a compatible iPhone, it 
doesn’t require any additional purchases, and 
the footage it outputs is almost second to 
none. Or try a webcam like the Anker 
PowerConf C300. Either way, think twice about 
spending $300 here until Razer updates 
Synapse to work on macOS. ALEX BLAKE

NOW THAT CONTINUITY Camera lets you use 
your iPhone as a Mac camera, does spending 
$300 on a webcam like Razer’s Kiyo Pro Ultra 
make sense in the current climate?

When you’re well–lit from the front, the 
camera juggles light and dark well. With a light 
behind you it isn’t quite so impressive, but it 
still produces a pretty well–balanced picture. 
Low lighting is its real strong point, though, 
and it’ll keep you bright and clear with minimal 

However, there’s a major problem. Despite 
being capable of 4K footage, the Kiyo Pro Ultra 
defaults to a measly 640 x 480 pixel resolution. 
Worse, Razer’s Synapse app doesn’t work with 
macOS, and it’s used to bump up that puny 

Third–party apps can increase the pixel 
count, and your best bet here is Camo Studio, 
which lets you adjust both resolution and 
frame rate (although you’ll need to pay to get 
anything higher than 720p). Apps like FaceTime 
and Zoom lack resolution options. Video–
recording apps like OBS can get 4K footage 
from Razer’s cam, but they’re not really built for 
video calls. You can change the resolution 
using Synapse on a Windows PC and the 
settings will carry across to macOS. We tried 
the camera on a PC and the 4K footage was 

THE BOTTOM LINE

The Razer Kiyo Pro 
Ultra offers great video 
output, but you’ll need 
a workaround to get it.

  Performs well in low light

  Very low default resolution

  Razer software not  
macOS compatible

  Extremely expensive

WEAK 
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The webcam can pan,  
tilt, and be mounted  
on a table or tripod.

Image rights: Razer.

D E S P I T E 
O F F E R I N G 
4 K ,  T H E 
K I YO  P R O 
U LT R A D E FAU LT S 
TO  A M E AS LY  
6 4 0  X  4 8 0  P I X E L 
R E S O LU T I O N

Tough testing, trusted ratings
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DO YOU NEED Wi–Fi all the way at the bottom 
of your backyard? With this neat weatherproof 
device, you can have it. It’s designed to be used 
indoors or out, and can be mounted on a post 
or screwed into a wall instead of sitting on a 
shelf or table if you wish. Download the Deco 
app to incorporate it into your current Wi–Fi 
network using its Access Point Mode, or use it 
as a replacement for the router you got from 
your Internet Service Provider (ISP). It’s 
compatible with TP–Link’s other Deco wireless 
products, so you can create a Wi–Fi mesh, with 
several access points eliminating dead spots 
around the house. The X50 Outdoor has 
parental controls (subscription required) and 
management features, but if you use it in 
Access Point Mode these are disabled.

The main advantage of Wi–Fi 6 is it can 
handle far more simultaneous connections 
without loss of performance. According to  
TP–Link, Deco X50 can handle over 150 

slowing down. Given the way we use the 

THE BOTTOM LINE

A decent enough 
device, but if you 
spend a little more on 
a tri–band option you 
can get better.

  Indoor or outdoor

  Create a Wi–Fi mesh

  Works with all ISPs

  Only dual band

GOOD 

streaming services, IP camera streaming, 
online video gaming, smart home devices and 
more, as well as going online with computers, 

advantage. It’s dual band, with 2.4 GHz and 5 
GHz channels, and we’re promised combined 
speeds of up to 3,000 Mbps (574 Mbps on 2.4 
GHz and 2,402 Mbps on 5 GHz).

In our tests, it performed admirably in a 

playing an Xbox game, streaming movies to 

several household gadgets, there was no lag on 
any of the devices. Of course, speeds and 
bandwidth could be improved further by using 
a tri–band device instead of this dual–band 
router, but that would prove more expensive. 
If you’re looking for a household family router 
or an outdoor access point for when you host a 
cookout, it won’t let you down. If you’re a 
small business owner who needs to support a 
large number of simultaneous connections all 
demanding a high degree of bandwidth, it’s 
probably not for you. IAN OSBORNE

You can set up the Deco X50 
indoors or outdoors.

TP–Link Deco  
X50–Outdoor Router
Bring Wi–Fi to your next cookout
$149.99  From www.tp-link.com

Features AX3000 dual–band Wi–Fi, Wi–Fi 6 compatible, IP65 waterproof and dustproof, PoE/AC Power 
Supply, 2 × Gigabit WAN/LAN Ethernet ports, covers up to 2,500 ft squared
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As you’d expect, Guybrush must face off against  
his arch nemesis LeChuck.

in beautiful high resolution. It looks great 
on a large iMac or external monitor.

Beware, though, the heavy emphasis on 
the “click” part of “point–and–click”, 
which means there’s an awful lot of back 
and forth. You’ll frequently be tasked with 

immediately rendered useless and must be 
replaced by something found in the 
location you just vacated. Much of the story 
feels like an extended fetch quest, which 
wears a little thin after a while.

It’s also not particularly challenging, 
even on the Hard setting. There’s not much 
of the crazy, creative thinking that infused 
LucasArts classic Day of the Tentacle to such 

beaten without much head scratching.
Still, Return to Monkey Island is an 

enjoyable romp, whether you love the 
original games or have never even heard of 
them. It’s not quite an instant classic, but 
it’s a great way for a salty sea dog to while 
away the hours. ALEX BLAKE

THE MONKEY ISLAND games 
have earned their place in the 
video game hall of excellence, 
but it’s been over a decade since 

the last release. Can Return to Monkey Island 
also be a return to past glories?

Help hapless hero Guybrush Threepwood 
as he launches an undercover mission to 

amid friends and foes new and old. Doing 
so is no easy feat with Mêlée Island under 
new management, and the new pirate 
leaders have little interest in helping 
Guybrush. Instead, he needs to sneak 
aboard a ship captained by his nemesis 
LeChuck and convince the crew to take  
him to the island where it all began.

WAS THAT A TALKING SKULL?
Despite its modern release, Return to 
Monkey Island retains many hallmarks of 
the classic point–and–click games of yore. 
There are items to combine into unlikely 
new tools, characters to charm, and clues to 
be found. It’s a real throwback.

It also bears the signature LucasArts 
graphical style, with gaudy colors and 
exaggerated features on every person, 
building and object. Unlike some of the 
later games in the series, Return to Monkey 
Island is cast in 2D, taking the old–school 
platformer visual style and reimagining it 

THE BOTTOM LINE

A great adventure for 
point–and–click fans.

  Classic pirate fun

  Great humor

  Beautiful graphics

  Too much fetching

GREAT 

Return to Monkey Island
Misadventure on the high seas
$24.99  From www.returntomonkeyisland.com

Needs macOS 10.13 or later

There are plenty of familiar 
faces from past Monkey 
Island games.

Tough testing, trusted ratings
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TYPING ON THE JLab GO is decent for a $20 
keyboard. It’s not in the same league as 
Apple’s Magic Keyboard, but it’s not a million 

press, and the arrow keys are in an inverted T 

touch than on Apple’s equivalent.
It’s also an impressively lightweight device, 

meaning you’ll have no trouble slipping it into 
a bag if you need to work on the go. The 
downside to its portable nature is that it feels a 

and you’ll hear its rear battery cover rattle, 

vibration from the board. It doesn’t feel like 
it’s about to fall apart, but Apple’s Magic 

JLab’s keyboard is also much louder than the 
Magic Keyboard, especially if you’re a rapid 
typist. Some of the keys near the edges are 

yourself making the odd mistake here and 

THE BOTTOM LINE

A budget keyboard 
with a few handy 
extras, the JLab GO 
isn’t going to dethrone 
the Magic Keyboard 
any time soon.

  Lightweight and portable

  Handy volume dial

  Loud to type on

  Feels a bit cheap

SOLID 

there as you miss the key you’re aiming for. 

outlay you do get a better, quieter typing 
experience than JLab’s keyboard. But if all you 
need is a budget board when you’re on the go, 
the GO may scratch that itch.

The JLab GO also has an unexpected party 
trick: an audio control located in the top–right 
corner. We didn’t expect this on a $20 
keyboard, and it works well and is a handy 
addition to the device. It’s a feature borne of 
necessity, since JLab has replaced the volume 
up/down keys on the function row with a few 
new keys: a calculator shortcut button, plus a 
screenshot key (which works like pressing 
Cmd+Shift+4). Annoyingly, the calculator key 
doesn’t work on macOS, and the function keys 
are quite small.

That aside, the JLab GO is a contender if you 
want a budget keyboard that won’t weigh you 
down on your travels. Just don’t expect it to 
feel like a million bucks. ALEX BLAKE

The audio roller is a 
pleasant surprise on such 
an affordable keyboard. JLab GO

A portable keyboard that won’t break the bank
$20  From www.jlab.com

Features Audio control dial, connects to three devices, switches between three key layouts, 2x AAA and 
2.4GHz dongle included, 11.24 x 0.96 x 5.13 in
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Solidly built, the speaker 
uses dual tweeters, a 
woofer and rear bass port.

IN A SEA of smart speakers, Audio Pro’s C5 
MkII leans very much on the “speaker” side of 
things. Although it has some software control 
it does not feature a microphone or any kind of 
digital assistant, so it’s really nothing like a 
HomePod, for example. Compact but very well 
built, the C5 MkII is designed to be somewhat 
portable with its leather carrying handle, 

really meant only for indoor use. Around the 

inputs and a subwoofer output should you 
wish to connect a turntable or some bass 
extension, respectively. 

In addition to the physical inputs the 
speaker has Bluetooth 4.2 and of course Wi–Fi, 
supporting AirPlay 2, Google Cast and 
multiroom operation. There’s a companion 
app you can use to get set up, though in our 
case it failed repeatedly to complete the 
process. Luckily you can also use Apple Home 
or Google Home to connect it to your Wi–Fi 
and after we did this, Audio Pro’s Connect app 
did then seem to recognize the speaker. 

THE BOTTOM LINE

A solid wireless 
speaker, but  
faces increasing 
competition from 
smarter rivals.

  Excellent design  
and build

  Warm, pleasing sound

  App needs improving

  Pricey for a  
non–smart speaker

GOOD 

As noted there’s no assistant running 
on the speaker, so everything is done via 
your smartphone where you can set up 
shortcuts to a range of streaming 
services, and up to six of these can be 
assigned to the shortcut buttons. 
There’s also transport controls, volume, 
and input select buttons here. The app 
allows you control of basic EQ as well as 
managing multiple speakers, and 
Spotify and Tidal Connect are supported. 

powered by a 25W amp and the two 
tweeters have 8W each. Frequency 
response is 50Hz – 20kHz, which means 
there isn’t a huge amount of bass at the 
lowest end. That aside the soundstage is 
fairly punchy, doing a decent job with a 
mixture of genres and sounding warm 

software features for $50 less than this 
speaker retails for. HOLLIN JONES

Audio Pro C5 MkII
A stylish wireless bookshelf speaker
$299  From www.audiopro.com

Features AirPlay 2, Home app compatibility, Bluetooth, RCA inputs, Dimensions: 5.1 x 9.8 x 5.9in   

Tough testing, trusted ratings
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The built–in 
calendar is a 
welcome addition.

contains things like newsletters 

That’s about it for Outlook’s 

won’t sort things like receipts 

scheduled messages — 
although the last two are 
limited to paid Microsoft 365 or 

Click an email thread and it 
expands to show each message 

Most of Outlook’s main 

MICROSOFT 
RECENTLY TRIED to 
carve inroads into 

making its Outlook for Mac 
email client free instead of 
requiring a Microsoft 365 

worth using?

Microsoft has included a few 
helpful extras for managing 

On the left is a sidebar with 

Outlook is an 
attractive app 
with a plethora of 
neat features.

sidebar containing Outlook tips 

SHOULD YOU DITCH MAIL?

better optimized than Apple’s 

helping to distinguish 

Mail lacks a sidebar for calendar 

Outlook integrates other 

customizable and provides a 
ton of control without 

Most options are found in the 
app’s settings menu rather 

Outlook’s upfront cost is the 
introduction of ads in the free 

Microsoft Outlook
Can Apple learn from Microsoft?
Free (with IAPs)  From https://outlook.com

Needs macOS 11.0 or later; Intel or Apple silicon Mac
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The right–hand 
sidebar provides a 
quick view of 
calendar events.

grained customization.

THE BOTTOM LINE

Outlook is an impressive email 
client that serves as your one–
stop productivity shop.

  Serious challenger to Apple’s Mail

  Now free to use

  Well–organized user interface

  iCloud calendar sync issues

EXCELLENT 

feel about Microsoft’s 

its adverts to look like genuine 

small “Ad” marker on each 

the main blemish on an 

Select the square icon in the 
bottom–left to view your calendars. 
Outlook can import calendars linked 
to third–party email accounts, but 

needs a workaround for iCloud 
calendars (since it doesn’t support 

CalDAV and CardDAV).

Sign in to your Outlook account on 
the web, click Calendars in the 

sidebar, then click Add calendar > 
Subscribe from web, paste the URL 

copied from iCloud, then click 
Import. Your iCloud calendar should 

now appear in Outlook.

Go to www.icloud.com
calendar. Click the sharing info 

button next to a calendar, then click 
Public Calendar and copy the URL. 

You can import this into Outlook 
(although you can’t edit iCloud 

calendar entries). 

APP TIPS

How to import your iCloud calendars

Outlook’s incorporation of 
calendars and tasks makes it a 

ALEX BLAKE

Tough testing, trusted ratings
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CARRYING MULTIPLE CHARGERS and cables can 
get tiresome, but Belkin’s 3–in–1 charging pad 
is designed to make your life easier if you own 
a recent iPhone, AirPods or Apple Watch, and 
preferably all three to really get the best value 
out of your purchase. Compact but very well 

with a 40W power supply which plugs into the 
underside neatly. In terms of its size, the pad 
is easy enough to carry around while traveling, 
or will sit unobtrusively on a desk. 

There are three sections, one for each device 
— a sensible approach which Apple tried to 
overcomplicate with its now–abandoned 
AirPower charger. The phone section will 
charge any wireless charging–compatible 
phone meaning an iPhone 8 or later, and is 
MagSafe compatible for iPhones 12 and later. 
It’s also compatible with MagSafe cases so you 
won’t have to remove them. 

You can place compatible AirPods cases or 
indeed other wireless–charging earbud cases 
onto the central section, and the Apple Watch 

THE BOTTOM LINE

A slick and powerful 
wireless charger with 
fast charging support 
for recent devices.

 Elegant solution for 
Apple devices

  Fast charging support

  Accommodates  
different Watches

   You pay a price for the 
convenience

EXCELLENT 

section comes with a magnetic puck that can 

mode. Underneath the Watch section is a dial 
that lets you adjust the height of the puck to 

is a nice touch.  
Using our test of an iPhone 11, AirPods Pro 2 

and an Apple Watch 4 charging at the same 
time from empty, we found that after 30 
minutes the charges were 32/35/29%, after an 
hour 66/73/70%, and after 1h30m all devices 
were fully charged. With Pro or Pro Max 
models you could add a little time to the 
iPhone charges, but with a 12, 13 or 14 you’d 

it’s a great way to keep your devices topped up 
or indeed get a quick recharge if your phone or 
Watch supports it. It’s arguably a little pricey 

devices, and a USB–C power output would have 
been nice, but it’s a much more neat and 
elegant solution than using multiple chargers, 
and portable to boot. HOLLIN JONES

Charge up to three devices 
at once, wirelessly with the 
included 40W PSU. Belkin BoostCharge Pro  

Elegant and powerful wireless charging
$149.99  From www.belkin.com

Features MagSafe for iPhones, adjustable Apple Watch puck height, charge at up to 15W (iPhone 12, 13 
and 14); 7.5W (iPhone 8–11), Apple Watch fast charging (7, 8 and Ultra models)
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are hardly thin on 
the ground. 
Instapaper, 

GoodLinks, Pocket, and Safari’s 
in–built Reading List option are 
the current leaders, but Matter 

Available as an app for iOS 
and iPadOS and an extension for 
Safari and other browsers on the 
Mac, Matter uses Apple’s 
ubiquitous Share icon to save an 
article. It appears in the Matter 
app in your queue, from where 
you can read it. It’s generally a 
more comfortable read than on 
the web page; no tedious 
pop–ups, annoying adverts or 
intrusive links to other articles. 
Relevant photographs are 
usually retained, though they’re 
sometimes missed. Where this 
happens, you can tap an icon 
and return to the article on its 

THE BOTTOM LINE

A novel, exciting and capable  
read–later app, but how many 
subscriptions can one wallet take?

  Articles easier to read in Matter

  Useful social features

  Audio features are great

  Subscription is expensive

GREAT 

website. There’s also no 
problem saving articles from 
behind a paywall either, as long 
as you’ve subscribed to the site 
in question. 

Organize your saved pieces 
with tags, sync with your other 
devices to the furthest point 
read, and have a piece read to 
you by a natural–sounding audio 
player. You can also save 
YouTube videos, and export 

post in a Twitter thread and the 
entire thread is sent to your 
queue. Pay for a monthly or 
yearly subscription and you can 
highlight text, make notes, add 
RSS feeds and even send an 
article to your Amazon Kindle. 

But saving articles is only half 
the story. Matter is also its own 
social network. Go premium and 
you can follow writers, having 
their work delivered to your 
inbox. Follow your friends and 
you can see what they’ve been 
reading and vice versa, 
including notes and highlights, 
though you can read privately 
without sharing too. 

Apart from a few minor 
interface nitpicks which will 
surely be sorted over time, our 
only real complaint here is the 

free version, but if you want  
the Premium features, the 
subscription is really rather 
expensive. It’s arguably the best 
read–later app available for 
Apple devices, but use the free 
version for a month or two 
before deciding whether to 
splash out on the Premium 
features. IAN OSBORNE

Matter: A Better 
Reading App 
Taking a new look at the read-later app
Free; $7.99 (premium monthly); $59.99 (premium annual);  
$149.99 (premium 3 years)  From https://getmatter.com

Needs iOS 15.0 or later, iPadOS 15.0 or later

Tough testing, trusted ratings
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> HARDWARE

CATEGORY PRODUCT WEB PRICE ISSUE

MESH ROUTER ASUS ZenWiFi XT9 asus.com $449.99 #201

4K USB–C MONITOR BenQ EW3280U benq.com $799.99 #169

THUNDERBOLT DOCK CalDigit Thunderbolt Station 4 caldigit.com $379.99 #199

KEYBOARD NuPhy Air75 Wireless Mechanical nuphy.com $109.95 #189

PORTABLE PRINTER Epson WorkForce WF–110W epson.com $299.99 #185

PORTABLE HDD Toshiba Canvio Flex 2TB storage.toshiba.com $79.99 #197

NAS DEVICE Asustor Lockerstor 2 Gen 2 AS6702T asustor.com $459 #205

WIRELESS CHARGER Belkin BoostCharge Pro Portable belkin.com $59.99 #197

DESKTOP SPEAKERS Creative Pebble Pro us.creative.com $59.99 #204

IN–EAR HEADPHONES Beats Fit Pro beatsbydre.com $199.99 #190

SECURITY CAMERA EufyCam 2C (two–pack kit) eufylife.com $239.99 #171

SMART SPEAKER HomePod mini apple.com $99 #176

OVER–EAR HEADPHONES Sony WH–1000XM5 sony.com $399.99 #197

AIRPLAY SOUNDBAR Sonos Beam sonos.com $449 #187

WEBCAM AnkerWork B600 Video Bar ankerwork.com $219.99 #191

PHOTO PRINTER Liene 4x6 photo printer amazon.com $136.99 #190

PORTABLE BATTERY PACK Anker 533 us.anker.com $49.99 #198

MOBILE DOCK Kensington 8–in–1 USB–C Mobile Hub kensington.com $77.55 #190

OFFICE CHAIR Branch Verve branchfurniture.com $549 #201

MOUSE Logitech MX Master 3S logitech.com $99.99 #198

ACTION CAMERA GoPro Hero 11 Black gopro.com $500 #202

SMART TV PLAYER Roku Streaming Stick 4K roku.com $49.99 #190

PORTABLE DAC iFi Go Blu $199 #189

PORTABLE SSD Crucial X8 crucial.com $219.99 #203

THUNDERBOLT 4 HUB Satechi Thunderbolt 4 Slim Hub satechi.net $199.99 #205

CD/DVD DRIVE NOLYTH External DVD Drive amazon.com $39.99 #204

TRAVEL CHARGER Mophie 3–in–1 travel charger zagg.com $149.95 #202

iPHONE GAME CONTROLLER Razer Kishi v2 razer.com $99.99 #203

Best of the best
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> iOS/iPadOS APPS

CATEGORY PRODUCT WEB PRICE ISSUE

TO DO (PRODUCTIVITY) Things 3 culturedcode.com $9.99 #194

WRITING Scrivener literatureandlatte.com $19.99 #138

EMAIL Spark sparkmailapp.com Free #190

PHOTO EDITOR Pixelmator Photo 2 pixelmator.com $4.99 #193

VIDEO EDITOR LumaFusion 3.0 $29.99 (IAPs) #186

CAMERA Obscura 3 obscura.camera $9.99 #196

RSS READER Reeder 5 reeder.app $4.99 #176

DESKTOP PUBLISHING $19.99 #206

NOTE–TAKING Notability 10 gingerlabs.com $8.99 #174

MIND–MAPPING MindNode 7 mindnode.com $14.99 #184

DOCUMENT SCANNER Genius Scan 6.0 thegrizzlylabs.com Free (IAPs) #182

CALENDAR Fantastical 3 $4.99/month #198

FITNESS Gentler Streak gentler.app Free (IAPs) #199

SHOPPING Grocery 3 smartgrocery.app Free #198

GRAPHICS Procreate for iPad procreate.art $9.99 #196

> macOS APPS

CATEGORY PRODUCT WEB PRICE ISSUE

TO DO (PRODUCTIVITY) Things 3 culturedcode.com $49.99 #194

WRITING Scrivener literatureandlatte.com $49 #200

EMAIL Spark sparkmailapp.com Free #190

PHOTO EDITOR Luminar Neo skylum.com $79 #194

VIDEO EDITOR Wondershare Filmora wondershare.com $109.99 #202

SCREEN CAPTURE ScreenFlow 9 telestream.net $129.00 #164

MUSIC CREATION Logic Pro apple.com $199.99 #141

PASSWORD MANAGER Secrets outercorner.com $19.99 #188

DESKTOP PUBLISHING Adobe InDesign adobe.com $20.99/month #162

BACKUP Carbon Copy Cloner bombich.com $39.99 #136

VIRTUALIZATION Parallels Desktop 18 parallels.com From $99.99 #201

TIME–TRACKING Tyme 3 $3.99/month #169

NOTE–TAKING Agenda agenda.com Free #204

AUDIO AND VIDEO CONVERTER Wondershare UniConverter wondershare.com $49.99/year #203

VIRTUAL PRIVATE NETWORK NordVPN nordvpn.com $11.95/month #186

Tough testing, trusted ratings
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